Contents

Introduction

How This Guide Is Organized .................................................. 8
Revision History ................................................................. 9

Chapter 1. Administering Siebel Analytics Web

About Working in the Registry ................................................. 14
Changing the Siebel Analytics Web ODBC DSN ......................... 19
Managing the Charting Settings forSiebel Analytics Web ............ 19
Setting the Configuration File Path ........................................ 21
Disabling the Feature to Remember Users’ Names and Passwords ... 21
Setting the Time to Expire for Client Connections ...................... 22
Administering Sessions ........................................................ 23
Setting the Time to Keep an Unsaved Request .......................... 27
Setting the Time to Cancel an Unattended Request ................... 27
Setting the Time to Log Users Off Automatically ....................... 28
Managing the Query Cache Settings for Siebel Analytics Web ....... 28
Settings for the Chart Image Server ....................................... 30
Configuring the Cookie Domain ............................................. 31
Managing URL Generation .................................................... 32

Chapter 2. Administering Siebel Answers

Configuring Pivot Table Settings ............................................ 38
Configuring the Maximum Number of Rows in Table View .......... 39
Changing the Default Currency ............................................. 40
Chapter 3. Administering Siebel Delivers

iBots and AntiVirus Software ........................................... 44
Disabling Siebel Delivers ................................................. 45
Changing the Directory in Which iBot Deliveries Are Stored ....... 46

Chapter 4. Administering Siebel Intelligence Dashboards

Creating and Deleting Shared Dashboards .......................... 48
Changing Dashboard Properties ......................................... 51
Creating Action Links ..................................................... 53
Integrating Siebel Answers Into Other Portals or Intranets ....... 54

Chapter 5. Administering the Siebel Analytics Web Catalog

Changing the Name and Location of the Siebel Analytics Web Catalog .... 58
About Automatic Backups ................................................ 59
Setting the Number of Automatic Backups of the Web Catalog ...... 61
Setting the Number of Minutes Between Backups of the Web Catalog .... 61
Creating a New Web Catalog ............................................. 62
Recovering From a Failure to Load the Web Catalog ................. 63
Moving a Web Catalog to Another System ........................... 64
Migrating Changes to Requests and Filters ........................... 66
About Analytics Catalog Manager ....................................... 67
Opening Analytics Catalog Manager .................................... 68
About the Analytics Catalog Manager Workspace ..................... 69
Working With Catalog Manager Properties .......................... 71
Copying and Pasting Content Between Web Catalogs ............... 74
Updating the Web Catalog to a Newer Version ........................ 75
Localizing Web Catalog Text Strings .................................... 78
Recommendations For Working with the Web Catalog ............... 80
Contents

Viewing Information About Dashboard Reports ............................................. 81
Administering Catalog Items ................................................................. 84

Chapter 6. Analytics Web Security
Overview of Siebel Analytics Web Security .............................................. 88
About Web Groups .............................................................................. 91
Web Group Types .............................................................................. 91
Administering Web Groups ............................................................... 93
Authentication .................................................................................... 97
Web Groups and Session Variables .................................................... 99
Inheritance of Permissions and Privileges ........................................... 101
About Setting Permissions ................................................................. 104
Setting Permissions Through the Administration Page ..................... 106
Setting Permissions Through the Catalog .......................................... 109
About Setting Privileges .................................................................... 112
Setting Privileges ............................................................................. 113
Default Privilege Assignments ......................................................... 115
Guidelines for Setting Up Security in the Web Catalog and Dashboards . 118

Chapter 7. Customizing the User Interface
Modifying UI Styles ............................................................................ 128
Customizing Non-Dashboard Components ....................................... 131
Customizing the User Interface Using XML Message Files ............... 131
Frequently Customized User Interface Messages .............................. 138
Customizing the Appearance of the Logon Pages ............................. 140

Chapter 8. Siebel Analytics Integration API
Go and Dashboard URLs for Siebel Analytics Integration .................. 142
Introduction

This guide will help you to configure and administer the Siebel Analytics Web components of Siebel Analytics Stand-Alone and Siebel Analytics applications.

Read this chapter to decide whether this guide is appropriate for your job role, find out if there are any particular areas of expertise you need to understand this book, and learn where you can go to find other Siebel Systems resources.

Although job titles and duties at your company may differ from those listed in the following table, the audience for this guide consists primarily of employees in these categories:

- **Siebel Application Administrators**: Persons responsible for planning, setting up, and maintaining Siebel applications.
- **Siebel Application Developers**: Persons who plan, implement, and configure Siebel applications, possibly adding new functionality.
- **Siebel System Administrators**: Persons responsible for the whole system, including installing, maintaining, and upgrading Siebel applications.

Intended users of this document include Webmasters and other administrators for the Siebel Analytics Web environment (referred to as Siebel Analytics Web administrators), and managers who are responsible for the installation, development, and system administration of decision support applications.

This guide assumes that you are knowledgeable in the areas of Siebel Analytics software, Web-based applications, general Internet infrastructure and Web design (including HTML and XML), decision support systems, and your operating system environment (Windows or UNIX).

Although as an administrator you might sometimes perform end-user procedures, this guide only covers administrator procedures. End-user procedures for Siebel Analytics Web are documented in *Siebel Analytics User Guide*. 
How This Guide Is Organized

Chapter 1, “Administering Siebel Analytics Web” describes post-installation configurations that are not specific to one of the four components of Siebel Analytics Web.

Chapter 2, “Administering Siebel Answers”, Chapter 3, “Administering Siebel Delivers”, Chapter 4, “Administering Siebel Intelligence Dashboards”, and Chapter 5, “Administering the Siebel Analytics Web Catalog” describe configuration and administrative procedures that are specific to one of these four components.

Chapter 6, “Analytics Web Security” covers the important topic of security from the perspective of access permissions.

Chapter 8, “Siebel Analytics Integration API” and Chapter 9, “Siebel Analytics Third-Party SQL Tool Integration Example” give information relating to integration with Siebel Analytics Web.
Revision History


March 2003 Bookshelf

Table 1. Changes Made in Rev. B for March 2003 Bookshelf

<table>
<thead>
<tr>
<th>Topic</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Added about 30 pages of information from Analytics Web Online Help that was not included in this book.</td>
</tr>
</tbody>
</table>
| Chapter 1, “Administering Siebel Analytics Web” | ■ Renamed chapter.  
 ■ Added the section “Administering Sessions.” |
| Chapter 2, “Administering Siebel Answers”       | Added the section “Changing the Default Currency.”                       |
| Chapter 3, “Administering Siebel Delivers”      | Added the section “iBots and AntiVirus Software.”                       |
| Chapter 4, “Administering Siebel Intelligence Dashboards” | Added the sections "Creating and Deleting Shared Dashboards" and "Changing Dashboard Properties." |
| Chapter 5, "Administering the Siebel Analytics Web Catalog" | ■ Renamed the section “Working with Properties and Permissions” to “Working With Catalog Manager Properties.”  
 ■ Moved information about permissions to Chapter 6, “Analytics Web Security.”  
 ■ Added the section “Administering Catalog Items.” |
### Table 1. Changes Made in Rev. B for March 2003 Bookshelf

<table>
<thead>
<tr>
<th>Topic</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 6, “Analytics Web Security”</td>
<td>■ Renamed chapter.</td>
</tr>
<tr>
<td></td>
<td>■ Rewrote entire chapter adding both background and detailed information. Note in particular the section called “Guidelines for Setting Up Security in the Web Catalog and Dashboards.”</td>
</tr>
<tr>
<td>Chapter 7, “Customizing the User Interface”</td>
<td>Added this section “Removing the Download (Excel) Hyperlink”. Renamed section to “Customizing the Appearance of the Logon Pages.”</td>
</tr>
</tbody>
</table>

---

### January 2003 Bookshelf

**Table 2. Changes Made in Rev. A for January 2003 Bookshelf**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction to Siebel Analytics Web</td>
<td>Removed chapter. Content is covered in <em>Siebel Analytics Server Administration Guide</em>.</td>
</tr>
<tr>
<td>Chapter 1, “Administering Siebel Analytics Web”</td>
<td>Added note to introduction about modification of JavaScript files. Moved information on editing the registry in the UNIX operating system from <em>Siebel Analytics Installation and Configuration Guide</em> to the section “About Working in the Registry” on page 14. Moved section to “Frequently Customized User Interface Messages” on page 138. Moved section to “Configuring Pivot Table Settings” on page 38.</td>
</tr>
<tr>
<td>“Resolution of Siebel Analytics WebMessage Name Tags”</td>
<td>Added section.</td>
</tr>
<tr>
<td>“Managing the Charting Settings for Siebel Analytics Web”</td>
<td>Corrected and completed information in this section.</td>
</tr>
</tbody>
</table>
Table 2. Changes Made in Rev. A for January 2003 Bookshelf

<table>
<thead>
<tr>
<th>Topic</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2, “Administering Siebel Answers”</td>
<td>New chapter containing information moved from Chapter 1.</td>
</tr>
<tr>
<td>Chapter 3, “Administering Siebel Delivers”</td>
<td>New chapter containing information moved from Chapter 1.</td>
</tr>
<tr>
<td>Chapter 4, “Administering Siebel Intelligence Dashboards”</td>
<td>New chapter</td>
</tr>
<tr>
<td>Chapter 7, “Customizing the User Interface”</td>
<td>New chapter</td>
</tr>
<tr>
<td>Chapter 8, “Siebel Analytics Integration API”</td>
<td>New chapter</td>
</tr>
<tr>
<td>Chapter 9, “Siebel Analytics Third-Party SQL Tool Integration Example”</td>
<td>New chapter</td>
</tr>
</tbody>
</table>

**Additional Changes**

- Changed “Siebel Analytics Dashboards” to “Siebel Intelligence Dashboards.”

- Specified online help as either *Siebel Analytics Web Online Help*, *Siebel Analytics Server Administration Tool Online Help*, or *Siebel Online Help*. 
Administering Siebel Analytics Web

This chapter provides general post-installation configuration and administration procedures that are not specific to Siebel Answers, Siebel Delivers, Siebel Intelligence Dashboards, or Siebel Analytics Web Catalog. Directions for configuring the components of Siebel Analytics Web listed above are given in later chapters.

Most of the procedures described in this chapter are performed through the registry.
About Working in the Registry

The registry contains information about the configuration of a computer, including the settings of programs installed on it. The operating system continually references the registry while the machine is running.

Several Siebel Analytics Web registry entries are created during the installation process. You can customize Siebel Analytics Web by modifying these entries and adding new entries.

**CAUTION:** Use extreme care when you modify the registry. Always back up the entire registry, or the registry keys that you plan to work on, before you make any changes.

Starting the Windows Registry Editor

You start the Windows Registry Editor using the Run command.

**To start the Windows Registry Editor**

1. From the Start Menu, select Run.
2. In the text box, type `regedit`. 
Figure 1 shows a number of registry keys for Siebel Analytics in the left pane of the Windows Registry Editor.

Figure 1. Registry Keys and Entries Created During Installation

In this book, the registry keys and entries are described as the path to the key followed by the entry name. The selected key in Figure 1 is the 7.5 key, which has three entries:

- Default, the entry for the key itself.
  
  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

  (Default)

- CatalogPath, the path for the Siebel Analytics Web Catalog:
  
  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

  CatalogPath

- DSN, the name of the Siebel Analytics Server data source name used by Siebel Analytics Web to access the Analytics server.
Opening the UNIX Registry Editor

The UNIX operating system does not have a registry like the Windows registry. However, the Siebel Analytics Web software includes a third-party registry implementation tool for UNIX machines. When used in graphical user interface mode, it allows a UNIX administrator to customize the operating characteristics of Siebel Analytics Web running on a UNIX machine in the same manner as a Windows administrator performs customization for a Windows machine. It can also be run as part of a script.

For information about the entries you can make to customize Siebel Analytics Web, see “To open the UNIX Registry Editor” on page 16.

NOTE: The registry entry examples given in this book assume that you are editing a Windows registry, so make any necessary substitutions in terms of file system paths, and add double quotes around registry entry values. For example, in the Windows environment, the value for the CatalogPath registry entry is: C:\SiebelAnalyticsData\Web\Catalog\default.webcat. In the registry implementation on UNIX, the equivalent entry is: /usr/local/SiebelAnalytics/default.webcat.

To open the UNIX Registry Editor

- To open the UNIX Registry Editor, use the regedit command.

  Entering regedit without any parameters opens the Registry Editor window.
Figure 2 shows the Registry Editor window in UNIX.

Figure 2. The Registry Editor Window in UNIX
You can also use switches entered with this syntax (see Table 3 on page 18 for details):

```
regedit [-c] [-e] [<file.reg>] [registry key]
```

### Table 3. Regedit Syntax

<table>
<thead>
<tr>
<th>Switch</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Omit this to use the graphical user interface mode. This indicates console mode. No X terminal is required. This is useful if you want to run a script to populate the registry entries.</td>
</tr>
<tr>
<td>e</td>
<td>Indicates export mode. When a value for <code>&lt;file.reg&gt;</code> is supplied, the default mode is import mode unless this switch is set. When you have finished modifying the registry, use this switch to merge your changes into the registry.</td>
</tr>
<tr>
<td>file.reg</td>
<td>The name of the registry file to edit. Use a descriptive name, such as <code>sa-web.reg</code>.</td>
</tr>
</tbody>
</table>
| registry key | The customization option that you want to use, for example:  
CatalogPath “/users/Web/Catalog/default.nqwcat”  
Use the paths given in *Siebel Analytics Web Administration Guide* and make the necessary substitutions for UNIX syntax. |

It is recommended that you use the graphical user interface mode (see Table 3) until you are familiar with adding entries. This requires that you use a terminal that has X Window, or a similar screen editor, available.

### Examples of Entries in the UNIX Registry Editor

- This command opens the Registry Editor window. Navigate to HKEY_LOCAL_MACHINESOFTWARESoftware/SiebelAnalytics Software/Web/7.5 and start adding entries.

  ```
  regedit
  ```

- This command merges the registry file sa-web.reg into the UNIX registry.

  ```
  regedit sa-web.reg
  ```
Changing the Siebel Analytics Web ODBC DSN

Siebel Analytics Web accesses a Analytics server repository with a single Siebel Analytics Server data source name (DSN). The installation process configures a DSN named Analytics Web for this purpose. For information on configuring a new or existing DSN, see Siebel Analytics Server Administration Guide.

If you change the name of the DSN, you need to update the registry to use the new name. This sample shows the entry in the Windows environment.

```plaintext
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\DSN
```

Siebel Answers must use a single DSN.

Managing the Charting Settings for Siebel Analytics Web

During the installation process, the registry key \Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Charts is created for the charting function. The Siebel Analytics Web administrator can create the following three registry entries under this key to change certain Siebel Analytics Web charting settings from their internal default entries.

If these registry entries are not created, the internal default entries shown for each entry are used. The following examples show how the entries appear in the Windows environment.
This entry, when created, overrides the internal default entry for the location used by Siebel Analytics Web as temporary storage for chart cache. The internal default is `dirletter:\SiebelAnalyticsData\Temp\nQWCharts`, where `dirletter` is the drive where the Siebel Analytics Web software is installed.

The location should be a fully-qualified path name, such as `d:\usr\SiebelWebChartCache`. The folder structure must exist before you start Siebel Analytics Web again.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Charts\CacheDirectory
```

This entry, when created, overrides the default interactive behavior of Siebel Analytics Web charts. Valid entries are Drill, Navigate and None. The default is Drill. This means that charts are created drillable by default.

If the entry is set to Navigate, charts are set up for navigation to the entry of `Charts\DefaultNavigationPath`. If the entry is set to None, charts are non-interactive; for example, clicking on a chart or chart region does nothing.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Charts\DefaultInteraction
```

If the entry of `Charts\DefaultInteraction` is set to Navigate, this entry overrides the default URL to which charts will navigate. The internal default URL is `http://www.siebel.com/`.

If the entry of `Charts\DefaultInteraction` is not Navigate, this entry is ignored.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Charts\DefaultNavigationPath
```
### Setting the Configuration File Path

You can override the path that Siebel Analytics Web searches for configuration files upon startup. The internal default location is $(DataDir)\Web\Config, where $(DataDir) is the resolved entry of:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Common\7.5\DataDir.
```

Siebel Analytics Web must have read permission to this path. The default data directory is SiebelAnalyticsData.

The following entry, when created, overrides the internal default location. The value set for the ConfigDir entry indicates the directory that is searched by Siebel Analytics Web for configuration files.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web
ConfigDir
```

### Disabling the Feature to Remember Users’ Names and Passwords

By default, users are asked if they want to have their user names and passwords remembered when logging on to Siebel Analytics Web. You can disable this by adding the following registry entry. When the entry is set to No, users will always have to type their user names and passwords.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
AllowRememberPassword "No"
```
Setting the Time to Expire for Client Connections

This entry overrides the number of minutes to elapse before browser client sessions are closed. The internal default is 3.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
ConnectionExpireMinutes "3"
Administering Sessions

To perform session administration, you must have the Manage Sessions privilege. For more information, see “Default Privilege Assignments” on page 115.

To view information about logged on users and running requests

1 In Siebel Answers, click the Admin hyperlink.

2 Click the Manage Sessions hyperlink.

The Sessions table of the Sessions area gives information about users who are logged on, including the unique Session ID which is based on the IP address of the connected computer.

The Cursor Cache table shows the status of requests made by users.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td>The name of the user who ran the request and last placed it into the cache. If two IDs are shown, the second ID is impersonating the first. For example, the entry lhurley/administrator means that the Administrator account logged on and impersonated lhurley. This can happen when the Scheduler starts an iBot on someone’s behalf. The Scheduler logs on and impersonates that user so security and content filters still apply.</td>
</tr>
<tr>
<td>Refs</td>
<td>The number of references to this entry since it was placed into the cache.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the request using this cache entry.</td>
</tr>
</tbody>
</table>

- **Running.** The request is currently running.
- **Finished.** The request has finished.
- **Queued.** The system is waiting for a thread to become available so the request can be processed.
- **Canceling.** The system is in the process of canceling the request.
- **Error.** An error was encountered during the processing or running of the request. Look in the Statement column for information about the error.
To cancel all running requests

1 In Siebel Answers, click the Admin hyperlink.
2 Click the Manage Sessions hyperlink.
3 Click the Cancel Running Requests link.
4 Click Finished.

To cancel one running request

1 In Siebel Answers, click the Admin hyperlink.
2 Click the Manage Sessions hyperlink.
3 In the Cursor Cache table, identify the request and click the Cancel link in the Action column.
   The user will receive a message indicating that the request was canceled by a Siebel Administrator.

To clear the Web cache

1 In Siebel Answers, click the Admin hyperlink.
2 Click the Manage Sessions hyperlink.
3 In the Cursor Cache table, identify the request and click the Close All Cursors link.
4 Click Finished.

To clear the cache entry associated with a request

1 In Siebel Answers, click the Admin hyperlink.
2 Click the Manage Sessions hyperlink.

3 In the Cursor Cache table, identify the request and click the Close link in the Action column.

To view the query file for information about a request
1 In Siebel Answers, click the Admin hyperlink.
2 Click the Manage Sessions hyperlink.
3 In the Cursor Cache table, identify the request and click the View Log hyperlink.

NOTE: Query logging must be turned on for data to be saved in this log file. For more information about query logging, see Siebel Analytics Server Administration Guide.
Setting the Time to Expire for Client Sessions

This entry overrides the number of minutes to elapse before browser client sessions are removed. The internal default is 1440 (24 hours).

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

ClientSessionExpireMinutes "1440"

NOTE: The entry must be greater than or equal to the entry specified for the setting SearchIDsExpireMinutes, described in “Setting the Time to Keep an Unsaved Request” on page 27.
Setting the Time to Keep an Unsaved Request

This entry overrides the time, in minutes, that an unsaved request will remain valid. This setting applies to unsaved requests only. The internal default is 180 (three hours).

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

SearchIDsExpireMinutes “180”

NOTE: The entry must be less than or equal to the entry specified for the setting ClientSessionExpireMinutes, described in “Setting the Time to Expire for Client Sessions” on page 26.

Setting the Time to Cancel an Unattended Request

This entry overrides the time to elapse, in minutes, before cancelling an unattended request. An unattended request is one that has not been accessed in the number of minutes specified by this setting. The internal default is 5.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

UnaccessedRunningTimeoutMinutes “5”

The minimum value is 2.

This setting handles the case where the user is at the Request screen in Siebel Answers and browses elsewhere, abandoning the request, at least temporarily. Do not set the value too small, however, as the user may return to the request.
Setting the Time to Log Users Off Automatically

This entry applies only to users who do not have the option Remember my ID and password selected at the Log In screen. It overrides the time to elapse, in minutes, before a user is automatically logged off. The default is 180 (three hours).

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
LogonExpireMinutes "180"

You can disable this setting by setting it to a value greater than the value for the setting ClientSessionExpireMinutes, described in “Setting the Time to Expire for Client Sessions” on page 26.

Managing the Query Cache Settings for Siebel Analytics Web

The following registry entries are available for managing the Siebel Analytics Web query cache. The query cache is accessed when users make requests in Siebel Answers. This is not the same cache that is accessed by the Analytics server.

This entry overrides the maximum amount of time, in minutes, that an entry in the query cache can exist before it is removed. The internal default is 60 (one hour).

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
CacheMaxExpireMinutes "60"

Depending on the number of queries being run, an entry may be removed before the time limit expires.

NOTE: The setting for CacheMinUserExpireMinutes, described next, can force an entry for a particular user to exist for a longer time than that specified by CacheMaxExpireMinutes.
Managing the Query Cache Settings for Siebel Analytics Web

- This entry overrides the minimum amount of time, in minutes, that an entry in the query cache can exist after it has been viewed by a particular user. The internal default is 10.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

  CacheMinUserExpireMinutes “10”

  For example, suppose CacheMaxExpireMinutes is set to 60 minutes. If a user views the entry during the 59th minute, the entry will exist for that user for an additional 10 minutes. This allows the user to continue paging through the data without requiring a new query to be run.

- This entry overrides the minimum amount of time, in minutes, that an entry in the query cache can exist before it is removed. The internal default is 10.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

  CacheMinExpireMinutes “10”

- This entry overrides the maximum number of open record sets that Siebel Analytics Web will keep open at any one time. The internal default is 10.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

  CacheMaxEntries “10”

  The minimum value is 3. For systems under significant loads, this value can be increased to 500 or 1000.
Settings for the Chart Image Server

Siebel Analytics Web uses a third-party charting engine to render charts. The engine is PopChart Image Server from Corda Technologies. The following registry entries allow you to override the default image type and browser client connection type. You need to create a POP key in the Chart key, and create the registry entries in the POP key.

- This registry entry allows you to override the image type generated by the PopChart Image Server. The internal default is Flash.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Charts\POP
  DefaultImageType

  The other choices are GIF (CompuServe Graphics Interchange Format) and PNG (W3C Portable Network Graphics). Flash images provide the greatest degree of interaction because they support mouseover behaviors (such as pop-up data labels), navigation and drilling.

- This registry entry overrides how a browser client will connect to the PopChart Image Server. The default is http://AnalyticsWeb_machine:81/? where AnalyticsWeb_machine is the machine name where Siebel Analytics Web is running, and 81 is the port number.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Charts\POP
  ServerPrefix

  This setting must be fully qualified with the port number (if other than 80) using the notation as shown.
Configuring the Cookie Domain

The following registry entries are used to configure the cookie domain:

- This entry allows the Siebel Analytics Web administrator to specify domain information for a cookie sent to the browser.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc\Siebel Analytics\Web\7.5
  CookieDomain

  There is no default entry.

- This entry allows the Siebel Analytics Web administrator to override the domain path that cookies will apply to. The internal default is “/”.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc\Siebel Analytics\Web\7.5
  CookiePath

- This entry allows the Siebel Analytics Web administrator to override the date on which persisted cookies will expire. For example, this is the date on which remembered passwords will expire (see “Disabling the Feature to Remember Users’ Names and Passwords” on page 21). The default value is “Tue, 31 Dec 2030 23:59:59 GMT”.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc\Siebel Analytics\Web\7.5
Managing URL Generation

The Siebel Analytics Web administrator can create the following registry entries under a URL key to override how Siebel Analytics Web generates URLs. Add the URL key under HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5.

Most of the URL registry entries are interrelated.

- This entry controls how Siebel Analytics Web generates absolute URLs to the ISAPI extension.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\URL

  AbsoluteCommandURLPrefix

  If an entry is explicitly specified, it must be of this form:

  protocol://server/virtualpath

  where virtualpath is the complete virtual path to Siebel Analytics Web. The default is determined separately for each client, based on the URL sent by the client to the Web server.

- This entry controls how Siebel Analytics Web generates URLs for static resources such as images, script files, style sheets, and other user-specified files.
Managing URL Generation

**HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\URL**

**ResourceServerPrefix**

If an entry is explicitly specified, it must be of this form:

```
protocol://server
```

If a virtual path is specified, it will be stripped off. If no entry is specified, this setting defaults to `protocol://server` from the `URL\AbsoluteCommandURLPrefix` setting.

This setting also allows a Siebel Analytics Web administrator to designate a separate Web server for delivering static resources, thereby reducing the load on the main Web server. This prefix will be used for the resources that have a fully qualified virtual path of the form `'/Path/file'`. If a resource file has a relative virtual path of the form `Path/file`, the prefix used will be the same used for commands to the Siebel Analytics Web ISAPI extension.

- This entry overrides the physical location of Siebel Analytics Web’s primary resource files (these are the resource files distributed with Siebel Analytics Web, not user-customized files such as custom styles or skins). The internal default is `$(INSTALL_DIR)\Web\App\Res`.

**HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\URL**

**ResourcePhysicalPath**

A full path must be provided. Siebel Analytics Web must have read permission to this path. For example, if this is a shared network resource, the Siebel Analytics Web administrator needs to make sure that the user under which Siebel Analytics Web is running has read access to the share, as well as read access to the file system the share is exported from.

**NOTE:** If this entry is different from the physical location of the Siebel Analytics Web DLLs, a setting for `URL\ResourceVirtualPath` must be specified.
This entry overrides the virtual path used for Siebel Analytics Web’s primary resource files as specified by the setting URL\ResourcePhysicalPath. These resource files and customer-defined resource files must be served from the same Web server.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\URL

ResourceVirtualPath

For generating relative URLs, the virtual path defaults to Res, assuming that the resource folder is present under the same virtual directory as the Siebel Analytics Web DLLs.

For generating absolute URLs, the entry of the value URL\AbsoluteCommandURLPrefix is used as the default.

The value must be a fully qualified virtual path of this form:

'\VirtualPath'

If you omit the leading slash, one will be added.

This entry overrides the physical location of resource files that are not part of a default installation. Such resource files include customized styles and skins. The internal default is $(DataDir)\Web\App\Res, where $(DataDir) is the resolved entry of HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Common\7.5\DataDir.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\URL

CustomerResourcePhysicalPath

A full path must be provided. Siebel Analytics Web must have read permission to this path. For example, if this is a shared network resource, the Siebel Analytics Web administrator needs to make sure that the user under which Siebel Analytics Web is running has read access to the share, as well as read access to the file system the share is exported from.

This entry overrides the virtual path used for resource files that are not part of a default installation as specified in the setting URL\CustomerResourcePhysicalPath. The internal default is Res.
This entry overrides whether Siebel Analytics Web will always generate fully qualified URLs for resource files that have fully qualified virtual paths. The internal default is No.

When set to No, resources and the ISAPI extension will be served from one server. When set to Yes, default resources are served from the same server as the ISAPI extension, and customer resources are served from another server. Depending on the value of the other settings described in this section, you could also set it up to have default and customer resources served from one server, and the ISAPI extension served from another server.
This chapter describes procedures that are used to administer Siebel Answers. For an introduction to Siebel Answers, see *Siebel Analytics User Guide*. 
Configuring Pivot Table Settings

You can set the maximum number of records that can be processed by a pivot table and the maximum number of populated cells that can be contained in a pivot table by editing entries in the registry.

- This registry entry overrides the maximum number of records that can be processed by a pivot table. The internal default is 20000.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
  CubeMaxRecords

- This registry entry overrides the maximum number of populated cells that Siebel Analytics Web will allow in a pivot table. The internal default is 150000. If the user exceeds this value, the server returns an error message when the pivot table is rendered.

  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
  CubeMaxPopulatedCells

For general information about editing the registry, see “About Working in the Registry” on page 14.
Configuring the Maximum Number of Rows in Table View

You can override the maximum number of rows that can appear in a table view.

The internal default is 10000. If the user exceeds this value, the server returns an error message when the table view is rendered.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

ResultRowLimit

For general information about editing the registry, see “About Working in the Registry” on page 14.
Changing the Default Currency

You can change the default currency displayed in the Siebel Answers user interface, for example, from French Francs to Euros.

If you are using Siebel Analytics applications, with no customizations, you only need to set the default data warehouse currency.

If you have created additional subject areas, the currency column data will be in the number format and you will need to make the changes described in the second procedure.

For more information about using formatting functions in Siebel Answers, see Siebel Analytics User Guide.

To set the default data warehouse currency

1. Open the currencies.xml file.
2. Search for the currency that you want to make the default.
3. Copy the entire currency element.
   For example, copy the currency tag for the Euro:
   ```
   </Currency>
   - <Currency tag="int:euro-l" type="international" symbol="_" displayMessage="kmsgCurrencyEuroLeft" digits="2" format="$ #">  
   <negative tag="minus" format="-$ ">
   </Currency>
   ```
4. Search for the text string int:wrhs, located towards the top of the file.
5. Select the entire element and replace it by pasting the copied element over it.
6. Replace the tag attribute so it reads int:wrhs.
   For example, replace tag="int:euro-l" with tag="int:wrhs".
To specify the currency for customized subject areas

1. Display the request that uses the subject area in the criteria page.
2. Click the Format Column icon for the currency column.
3. If necessary, clear the Use Default Data Format check box.
4. In the Treat Numbers As drop-down list, select Currency.
5. In the Currency Symbol drop-down list, select the currency.
6. In the Use these Settings drop-down list, select: as the system-wide default for this data type.
7. Repeat the process for any other columns.
This chapter describes procedures used to administer Siebel Delivers. For an introduction to Siebel Delivers, see *Siebel Analytics User Guide*. 
iBots and AntiVirus Software

Some antivirus software programs enable a script blocking feature, which attempts to block calls made by scripts to system objects.

iBots and their scheduling component, Siebel Analytics Scheduler, use scripting to access the Windows file system and other system objects. Antivirus features can therefore block iBot script calls.

It is recommended that you disable antivirus program script blocking on the computer on which Siebel Analytics Scheduler is installed.
Disabling Siebel Delivers

Siebel Delivers is an optional component of Siebel Analytics Web that is enabled by default. To disable Siebel Delivers, you must edit the registry.

The following samples show how the entries appear in the Windows environment.

- The following registry entry specifies whether Alerts are enabled. The default value is Y for Yes. To disable Alerts, set this to N for No.

  ```
  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Alerts
  Enabled
  ```

- The following registry entry identifies the name of the machine running Siebel Analytics Scheduler. If Siebel Analytics Scheduler is running on the local machine, this is populated with the name of the local machine.

  ```
  HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5\Alerts
  ScheduleServer
  ```

For general information about editing the registry, see “About Working in the Registry” on page 14.
Changing the Directory in Which iBot Deliveries Are Stored

The following registry entry overrides the directory in which iBot deliveries are stored. The Deliveries directory is, by default, stored in the same location as the Web catalog.

```
HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web

PersistentStorageDirectory
```

At startup, Siebel Analytics Web will attempt to create this directory. (The registry value “Changing the Name and Location of the Siebel Analytics Web Catalog” on page 58 defines where the Web Catalog is stored.)

For general information about editing the registry, see “About Working in the Registry” on page 14.
End users with appropriate privileges can modify personal and shared Siebel Intelligence Dashboards, including the addition of pages, columns, sections, and content. End users cannot create dashboards.

Administrators can create and manage dashboards, using the procedures in this chapter. For an introduction to dashboards and end-user procedures for modifying them, see *Siebel Analytics User Guide*. 
Creating and Deleting Shared Dashboards

Before you create shared dashboards, make sure you have planned your catalog folder structure and security strategy. Guidelines for creating a shared dashboard, within the broader context of catalog structure and security framework, are given in “Guidelines for Setting Up Security in the Web Catalog and Dashboards” on page 118.

For more information about shared folder structure in the catalog see Chapter 5, “Administering the Siebel Analytics Web Catalog.”

For more information about permissions, see Chapter 6, “Analytics Web Security.”

Overall, to create a shared dashboard, you first create the dashboard and then add pages, sections, and content. You can also assign Web Groups permissions to access the dashboard. Users who are members of more than one Web Group can select the dashboard they see by default from all of the dashboards to which they have permissions.

This section describes, from an administrator’s perspective, how to create and delete dashboards, and add sections. For more information about adding pages, sections, and content from an end-user’s perspective, see Siebel Analytics User Guide.

To create a shared dashboard

1 Click the Admin link on the main page in Siebel dashboards, Siebel Answers, or Siebel Delivers.

2 Click the Manage Intelligence Dashboards link.

3 Scroll down and click the Create a new Intelligence Dashboard link.

   The Create Dashboard page appears.

4 Select the appropriate Group Folder from the drop-down list.

   The members of this Web group (and other groups and users with appropriate permissions) will have Read access to the shared dashboard.

5 Enter a name for the dashboard in the Dashboard Name text box.
In the Dashboard Builder text box, type in the name of the user or Web Group that can make changes to the dashboard.

For information about creating Web Groups, see “Web Groups and Session Variables” on page 99.

Before you can add a section to a dashboard, you must first add a page. For information about adding pages to dashboards, see Siebel Analytics User Guide.

To add a section to a dashboard

1. Navigate to the dashboard page to which you want to add section.
2. Click the Add Folder link.

The New Section link creates a folder directly in the dashboard, underneath the \_Portal folder. The Add Folder link allows you to select a folder anywhere in the /Shared catalog and add it as a section to your dashboard. Folders added within the dashboard using the New Section link are seen only when the dashboard is being viewed, so they cannot be shared between dashboards. Folders added to the dashboard using the Add Folder link can be accessed or reused by anyone with Read permission to the folder.

3. In the Add Folder to Dashboard page, from the list of shared group folders that you created, click the appropriate group folder.

The appropriate group could be the group to which this dashboard belongs, or the Common folder. For common sections, such as weather, stock information, and so on, add the folders to the Common folder. Otherwise, add them to the appropriate group folders.

4. Click the Create New Folder link.
5. Enter a name for the Folder.
6. Click the Create Folder button.

The page you are now on shows the new folder and section you created within the Group folder that you chose earlier.

7. Click the Add to Dashboard button.

The empty section appears in the dashboard.
8 Click the Edit button (not the Edit Column hyperlink) and add content as usual.
9 Repeat this process to create any additional sections that you need.

To delete a dashboard
1 In Siebel Answers, click the Admin hyperlink.
2 Click the Manage Intelligence Dashboards hyperlink.
3 Locate the dashboard you want to change and click the Delete icon.
   The Confirm Deletion page appears.
4 Click Yes.
5 Click Finished.
Changing Dashboard Properties

You can change dashboard properties in the Dashboard Properties page.

To change a dashboard property

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Intelligence Dashboards hyperlink.
3. Locate the dashboard you want to change and click the Properties icon.
Follow directions in the table to change the property.

<table>
<thead>
<tr>
<th>Dashboard Property Change</th>
<th>Directions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>In the General Properties area, select the style from the Style drop-down list. For more information about styles, see Chapter 7, “Customizing the User Interface.”</td>
</tr>
</tbody>
</table>
| Devices on which the dashboard is available | In the General Properties area, select one or more of the following icons:  
  ■ Desktop Browser  
  ■ Mobile Phone  
  ■ Voice Browser |
| Devices on which the individual pages are available | In the Existing Pages table, identify the page and select the appropriate Enable/Disable Device check boxes in the Devices columns. This provides finer control than the devices on which the dashboard is available. |
| Order in which the page tabs appear | In the Existing Pages table, identify the page and click the Move Up or Move Down arrow to change the order in which the page appears. |
| Deletion of a page | In the Existing Pages table, identify the page and click the Delete icon. |
| Name of a page | In the Existing Pages table, identify the page and click the Rename icon. Follow directions on the user interface. |
| Permissions for a dashboard or page | For information about changing dashboard permissions, see “About Setting Permissions” on page 104. |
Creating Action Links

Siebel Analytics action links allow end users to navigate from their analytic dashboards to a record in a Siebel operational application. Siebel Analytics applications contain prebuilt action links in reports and dashboards. For example, a user can drill down directly from a Siebel Sales Analytics dashboard to a specific record in a Siebel Sales view. Drilldown is based on the row-id column contained in a report.

**NOTE:** End users must have the appropriate permissions and responsibilities to access the view, and any drilldown hyperlinks.

To create an action link

1. Identify the target Siebel operational application view.
2. Select the Siebel operational application view or applet that you want to drill down to, and select Help > About View.

   A pop-up window shows the names of the view and applet. Note the view and list applet names. You will need these names in **Step 5**.

3. Using a Subject Area that is appropriate for the target applet, use Siebel Answers to create a new Analytics report with the ROW_ID column in it, for example, Account_Row_ID.

4. Click the Properties icon for the column.

   The Edit Column Format screen appears.

5. Make the following changes:
   a. Clear the option Default Data Format.
   b. Select the option Treat Text as Custom Text Format.
   c. Enter the following HTML, substituting the appropriate view name and list applet names. The following example HTML shown uses All Account List View as the View Name, and Account List Applet as the target applet.
Integrating Siebel Answers Into Other Portals or Intranets

The following customization settings are available for integrating Siebel Answers into other portals and intranets without requiring the use of Siebel Intelligence Dashboards. These settings are configured in XML message files.

You can:

- Change the text of the dashboards link.
- Change the URL that users should be directed to when clicking on that link.

**NOTE:** Make sure that you first review the information in “Customizing the User Interface Using XML Message Files” on page 131 before making any integration changes.
To change the text of the dashboards link
This is controlled by a message entry in the file UIMessages.xml. This file is located in the folder Web\App\Res\l_xx\Messages in the Siebel Analytics Web installation directory, where xx is the language identifier of the selected locale. The name of the message is “kmsgUIPortal”, and it has the following form:

```xml
<WebMessage name="kmsgUIPortal">
  <TEXT>Dashboards</TEXT>
</WebMessage>
```

The default text is Dashboards. If, for example, you wanted to change this text to be your company’s intranet, you could change it to this:

```xml
<WebMessage name="kmsgUIPortal">
  <TEXT>Intranet</TEXT>
</WebMessage>
```

To change the destination for the dashboards link
This is controlled by a message entry in the file ControlMessages.xml, located in the folder Web\App\Res\Messages in the Siebel Analytics Web installation directory. The name of the message is “kmsgPortalLink”, and it looks like this:

```xml
<WebMessage name="kmsgPortalLink">
  <HTML>
    <A insert="1">
      <MessageRef name="kmsgUIPortal" />
    </A>
  </HTML>
</WebMessage>
```

The default location is Siebel Intelligence Dashboards (indicated by the reference to insert = "1", which is an internal reference). If, for example, you wanted to change this to be your company’s intranet, you could include the appropriate attributes and change it to point to that location instead:
If no location is specified, no link will appear in Siebel Answers.

For more information about controlling the default appearance and behavior of the Siebel Analytics Web user interface, see “Customizing the User Interface Using XML Message Files” on page 131.
This chapter describes how to administer the Siebel Analytics Web Catalog. It provides information about basic maintenance procedures, such as the steps used to create a new Web Catalog, recover from a Web Catalog load failure, or move the Web Catalog to another system. It also provides information about more advanced procedures that you can perform using Analytics Catalog Manager, such as upgrading the Web Catalog to a newer version.

For organizations that have Siebel Analytics applications, this chapter also explains how to use Analytics Catalog Manager to locate the names and descriptions of the reports delivered with preconfigured dashboards.
Changing the Name and Location of the Siebel Analytics Web Catalog

The installation process sets the name of the Web Catalog to default.webcat for Siebel Analytics stand-alone sites, and to SiebelAnalytics.webcat for organizations that have Siebel Analytics applications.

The default location of the Web Catalog is the folder \SiebelAnalyticsData\Web\Catalog.

If you move the Web Catalog or change its name, you need to modify the following registry value. This sample shows how the value appears in the Windows environment.

    HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5
    CatalogPath

For general information about editing the registry, see “About Working in the Registry” on page 14.
About Automatic Backups

The default location for the Web Catalog is \SiebelAnalyticsData\Web\Catalog. Siebel Analytics Web maintains automatic Web Catalog backup files and the version file in this location. Web Catalog backup files are useful when the Siebel Analytics Web administrator is customizing or testing Siebel Analytics Web content. The version file is used to help maintain Web Catalog integrity.

For information about changing the location of the Web Catalog, see “Changing the Name and Location of the Siebel Analytics Web Catalog” on page 58.

Backup Files

By default, Siebel Analytics Web performs a Web Catalog backup every five minutes. The backup files are saved into the same location as the in-use Web Catalog. Automatic backups are identified by nnn.autosave appended to the Web Catalog name, where nnn represents the sequential number assigned to the backup.

For example, in Windows, if the path to the Web Catalog is:

```
c:\SiebelAnalyticsData\Web\Catalog\SiebelAnalytics.webcat
```

then the third backup file is:

```
c:\SiebelAnalyticsData\Web\Catalog\SiebelAnalytics.webcat.03.autosave
```

The default number of Web Catalog backup files is 10. After 10 Web Catalog backup files have been created, the backup process reuses the sequential numbers. For example, the 11th Web Catalog backup file takes the extension 01.autosave, and replaces the Web Catalog backup file that had this extension previously.

You can control the number of automatic Web Catalog backup files and the interval between them. For more information, see “Setting the Number of Automatic Backups of the Web Catalog” on page 61 and “Setting the Number of Minutes Between Backups of the Web Catalog” on page 61.

The Version File

Information about the last known good Web Catalog backup is stored in a file ending in .version. For example, in Windows, using the example locations shown in the preceding section, the current version of SiebelAnalytics.webcat would be tracked in:

```
c:\SiebelAnalyticsData\Web\Catalog\SiebelAnalytics.webcat.version
```
About Automatic Backups

The version file is interrogated during Siebel Analytics Web startup:

■ If the version file does not exist, the Web Catalog is read from the original path specified in the CatalogPath registry key. (For more information about this key, see “Changing the Name and Location of the Siebel Analytics Web Catalog” on page 58.)

■ If the path does not exist, the Web Catalog will be created in the default location \SiebelAnalyticsData\Web\Catalog\.

■ If the version file exists, the backup file that it references (nnn.autosave) must also exist. If the backup file does not exist, Siebel Analytics Web will not start.

The version file is updated during Siebel Analytics Web shutdown. After a successful shutdown, the version file includes an entry indicating that the Web Catalog was successfully written to the original catalog path.

Setting the Number of Automatic Backups of the Web Catalog

Siebel Analytics Web automatically performs backups of the Web Catalog. The following registry entry overrides the maximum number of automatic backups of the Web Catalog that Siebel Analytics Web should create. The internal default is 10.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

CatalogMaxAutoSaves “10”

The minimum value is 3. Automatic backups are identified by nnn.autosave appended to the catalog name, where nnn represents the sequential number assigned to the backup.

For more information about automatic Web Catalog backups, see “About Automatic Backups” on page 59.

For general information about editing the registry, see “About Working in the Registry” on page 14.

Setting the Number of Minutes Between Backups of the Web Catalog

The following registry entry overrides the number of minutes that the Analytics server will wait between creating automatic Catalog backups. The internal default is 5.

HKEY_LOCAL_MACHINE\SOFTWARE\Siebel Systems, Inc.\Siebel Analytics\Web\7.5

CatalogAutoSaveMinutes “5”

For general information about editing the registry, see “About Working in the Registry” on page 14.
Creating a New Web Catalog

This procedure explains how to create a new Siebel Analytics Web Catalog.

To create a new Web Catalog


   **NOTE:** When Analytics Web is installed on a Microsoft IIS web server, the server creates temporary files for its web caching capability in a location specified by the Microsoft IIS installation. If the Analytics Server is stopped before the Analytics Web server, these temporary files usually remain, consuming disk space.

2. Stop these other services:
   - Siebel Analytics Server
   - Siebel Analytics Scheduler
   - Siebel Analytics Cluster Server
   - IIS Admin Service (Microsoft Internet Information Server), and any additional services that it wants to stop

3. Set the CatalogPath registry key to point to a catalog path that does not exist.
   For details, see “Changing the Name and Location of the Siebel Analytics Web Catalog” on page 58.

4. Make sure that there is no version file associated with the new Web Catalog and path and that the new target directory is empty.

5. Restart the services.
Recovering From a Failure to Load the Web Catalog

Siebel Analytics Web attempts to load the Web Catalog as part of its startup procedures. If it cannot load the Web Catalog, a failure message will be logged in the operating system’s application event log, and no one will be able to access Siebel Analytics Web. When possible, the system will attempt to load the last saved Web Catalog, determined from the version file. (For information about the version file, see “About Automatic Backups” on page 59.)

To recover from a failure to load the Web Catalog


   **NOTE:** When Analytics Web is installed on a Microsoft IIS web server, the server creates temporary files for its web caching capability in a location specified by the Microsoft IIS installation. If the Analytics Server is stopped before the Analytics Web server, these temporary files usually remain, consuming disk space.

2. Stop these other services:
   - Siebel Analytics Server
   - Siebel Analytics Scheduler
   - Siebel Analytics Cluster Server
   - IIS Admin Service (Microsoft Internet Information Server), and any additional services that it wants to stop

3. Make a backup of files related to the Web Catalog.

4. Rename the latest backup file (nnn.autosave) to the name of the original Web Catalog. For example, rename `SiebelAnalytics.webcat.03.autosave` to `SiebelAnalytics.webcat`.

5. Delete the associated version file (.version) file.

6. Restart the services.

If the Web Catalog still fails to load, repeat Step 3 through Step 6 with earlier backup files until Siebel Analytics Web starts successfully.
Moving a Web Catalog to Another System

This procedure explains how to move an existing Web Catalog to another Analytics installation.

**To move an existing Web Catalog to another system**


   **NOTE:** When Analytics Web is installed on a Microsoft IIS web server, the server creates temporary files for its web caching capability in a location specified by the Microsoft IIS installation. If the Analytics Server is stopped before the Analytics Web server, these temporary files usually remain, consuming disk space.

2. Stop these other services:

   - Siebel Analytics Server
   - Siebel Analytics Scheduler
   - Siebel Analytics Cluster Server
   - IIS Admin Service (Microsoft Internet Information Server), and any additional services that it wants to stop

   This results in the Web Catalog being written to the path shown in the CatalogPath registry key. (For more information about this key, see “Changing the Name and Location of the Siebel Analytics Web Catalog” on page 58.)

3. Verify successful shutdown by checking that the latest modified Web Catalog file is the original Web Catalog file (it has a .webcat extension), and not a backup file (an nnn.autosave extension).

4. Copy the original Web Catalog file to the appropriate location on the new system.

   Optionally, you can also copy the version file (a .version extension).
5 Restart the services.

**NOTE:** If you do not want to stop the services, you can copy the related Web Catalog files to the appropriate location on the new system. This includes the original Web Catalog file (.webcat extension), the Version file (.version extension), and the Web Catalog backup files (nnn.autosave extensions).
Migrating Changes to Requests and Filters

When you create and save requests and filters in Siebel Analytics Web, the objects are saved in the Web Catalog. The requests and filters are saved with the logical object references as they exist in the Siebel Analytics metadata in the Presentation Layer of the Siebel Analytics Server Administration Tool.

If the Presentation Layer metadata that affects these is changed through the renaming of objects, aliases are maintained for these objects that the Web Catalog can reference.

However, if the Presentation Layer metadata changes through the following ways, the link from the stored object in the Web Catalog to the metadata will be broken:

- Aliases are deleted
- Objects are moved between Presentation Catalog Folders in the presentation layer

To repair those links within a stored request, you need to refresh the requests and filters.

To refresh requests and filters

1. Log on to Siebel Analytics Web and access Siebel Answers.
2. Open the broken request and click the Advanced tab.
3. Click the Enter SQL link.
4. Change the FROM clause to reference the new Subject Area (Catalog Folder in the Presentation Layer) where the SELECT columns now reside.
5. If the column names have been changed, those changes must also be applied.
6. Reapply any required filters using the new Presentation Layer definitions.
7. Redefine any affected saved filters using the new Presentation Layer definitions.

The changes will be applied the next time that the Siebel Analytics Server service and the IIS Admin Service are started.
About Analytics Catalog Manager

Analytics Catalog Manager is a tool for Siebel Analytics Web administrators to perform offline management of the Siebel Analytics Web Catalog. It should be installed on a secure machine accessible only to Siebel Analytics Web administrators. Administrators can use Analytics Catalog Manager to perform the following functions:

- Administrators can rename and delete content, and move and copy content within and between Web Catalogs. This is critical for installations that maintain distinct test and production systems, as well as those that are creating content on top of the Siebel Analytics Stand-Alone.

- Administrators that have one or more Siebel Analytics applications installed can use Analytics Catalog Manager to generate a list of dashboard reports. The reports are distributed with Siebel Analytics applications.

- Analytics Catalog Manager allows administrators to upgrade their Siebel Analytics applications to new versions without losing any site-specific changes and enhancements.

- Administrators that need to localize content can use Analytics Catalog Manager to export text strings for translation, and then import them when the translation has been finished.
Opening Analytics Catalog Manager

Use only the procedure that follows to open Analytics Catalog Manager. Analytics Catalog Manager operates only in offline mode and does not require a login. Because it operates only in offline mode, make sure you are not working on a live Web Catalog. In other words, stop the Siebel Analytics Web services.

To open Analytics Catalog Manager


   **NOTE:** When Analytics Web is installed on a Microsoft IIS web server, the server creates temporary files for its web caching capability in a location specified by the Microsoft IIS installation. If the Analytics Server is stopped before the Analytics Web server, these temporary files usually remain, consuming disk space.

2. Stop these other services:
   - Siebel Analytics Server
   - Siebel Analytics Scheduler
   - Siebel Analytics Cluster Server
   - IIS Admin Service (Microsoft Internet Information Server), and any additional services that it wants to stop.

3. On the machine where Analytics Catalog Manager is installed, choose Start > Programs > Siebel Analytics 7.5 > Analytics Catalog Manager.

   The Analytics Catalog Manager window opens.

4. When you have finished working with Analytics Catalog Manager, restart the services.
About the Analytics Catalog Manager Workspace

Figure 3 shows how the Analytics Catalog Manager workspace appears immediately after opening SiebelAnalytics.webcat, which is the Web Catalog distributed with Siebel Analytics applications.

Figure 3. Analytics Catalog Manager Workspace

To view the Web Catalog tree structure

- Either:
  - Double-click the Web Catalog icon.
  - Click a folder in the right pane.

Folders

The shared folder contains content that is shared among Analytics Web users. This includes the preconfigured dashboards and reports that are distributed with Siebel Analytics applications, and other items such as shared filters.

The system folder contains administrative elements of Siebel Analytics Web. Some of these elements are distributed with the product, and others are set up by the Siebel Analytics Web administrator, such as privileges.
The users folder contains content that Analytics Web users with the appropriate permissions have saved to their personal folders, such as individual reports.

**Analytics Catalog Manager Columns**

The right pane of the Analytics Catalog Manager has five columns. Two columns, needing additional explanation, are described here.

**Type.** Identifies the type of item. Items that are identified as “unknown file” are generally internally-used items, and their type is not exposed in Analytics Catalog Manager.

**Permissions.** Shows the available permissions for the associated item in the workspace, based upon the users and groups that have access to that item. For more information about setting permissions, see “Setting Permissions Through the Catalog” on page 109.
Working With Catalog Manager Properties

Analytics Catalog Manager allows Siebel Analytics Web administrators to work with a subset of the administration functions available in Siebel Analytics Web. For example, you can modify an item’s properties, and change user and group permissions to items in the Web Catalog.

For more information about setting permissions, see “Setting Permissions Through the Catalog” on page 109.

Other administration tasks, such as setting up new Web Groups, are performed using the administration features in Siebel Analytics Web.

To view properties for an item

- Double-click the item, or right-click the item in the Name list and choose Properties.

  This opens the Properties window for the item.
Figure 4 is an example of the Properties window for the report named Partner Pipeline This Quarter. This report is from the Overview page on the Channel Sales dashboard in the Siebel Partner Analytics application.

To hide an item from display in Siebel Analytics Web, you can select the Hidden option.

Figure 4. Properties Window
The Read Only option is unused. The System option indicates that the item is maintained internally and should not be altered.

**NOTE:** The New button is used to create a new property. You should use it only if instructed to do so by Siebel Systems.
Copying and Pasting Content Between Web Catalogs

This section describes how to move content between Web Catalogs.

Web Catalogs are structured in hierarchical folders. When copying or merging items, remember to also copy any items that are associated with them, such as dashboard folders, request links, and requests. URL paths may need to be re-established after a copy or merge operation if the entire folder path is not copied, for example, if added to the dashboard as a link or text.

**NOTE:** If you want to upgrade your existing Web Catalog with a newer version received from Siebel Systems, see “Updating the Web Catalog to a Newer Version” on page 75.

**To copy and paste content between Web Catalogs**

1. Make backup copies of both Web Catalogs.

2. Choose File > Open from the Analytics Catalog Manager toolbar and select the first Web Catalog to open.

   This should be the Web Catalog that you want to change. The name of the Web Catalog that you opened appears in the title bar.

   **TIP:** It is recommended that you first open the Web Catalog that you want to change. If the catalogs have the same name, rename the second catalog before opening it.

3. Using the same instance of Analytics Catalog Manager, choose Choose File > Open from the Analytics Catalog Manager toolbar, and then select the second Web Catalog to open.

   This should be the Web Catalog that contains the content you want to copy.

   A second instance of Analytics Catalog Manager opens. The name of the second Web Catalog appears in the title bar of the second instance.
4 If necessary, reposition both instances of Analytics Catalog Manager on your screen so you can clearly see the title bars of both Analytics Catalog Manager instances.

5 To view the items that you can work with, expand the tree structure in the left pane, or double-click an item in the right pane.

6 To copy content, highlight the source item in the source (second) Web Catalog and choose Edit > Copy. Then, highlight the corresponding target item in the target (first) Web Catalog and choose Edit > Paste.

You can also use drag-and-drop to copy and paste content.

Updating the Web Catalog to a Newer Version

This section is for organizations that have Siebel Analytics applications and have customized Web Catalog content. It explains how to merge your current Web Catalog with a newer version received from Siebel Systems.

**NOTE:** If you made no changes to the Web Catalog distributed with version 7.0.4, this section does not apply to you. You can begin using the SiebelAnalytics.webcat Web Catalog distributed with version 7.5.

The update is done using Analytics Catalog Manager. The process compares the base Web Catalog distributed with the previous version with your customized Web Catalog to get a baseline of the changes, and then merges your existing Web Catalog content with the content from version 7.5. This process preserves any site-specific changes that have been made to your Web Catalog, and allows Siebel Analytics Web administrators to accept or reject specific changes.

The update makes use of three Web Catalogs:

- The *Prior Release Siebel Catalog*, which is the Web Catalog that you received with your currently-installed Siebel Analytics application. For most sites, this will be the Web Catalog distributed with version 7.0.4. It is also distributed at the root level of the version 7.5 installation CD-ROM as the file SiebelAnalytics-7.0.4-GA.webcat.
The Current Release Siebel Catalog, which is the Web Catalog that is installed with version 7.5 as the file SiebelAnalytics.webcat.

The Current Customer Catalog, which is the Web Catalog that you are currently using. In the following procedure, you will copy and rename this to SiebelAnalytics.webcat.old.

To update the Web Catalog to a newer version

1. Make a backup copy of your Current Customer Catalog, rename it to SiebelAnalytics.webcat.old, and move it to a temporary location.

   This is to make sure that a copy of your current Web Catalog is available for use during the upgrade process.

2. Install the new software version received from Siebel Systems according to the instructions given in Siebel Analytics Installation and Configuration Guide.

   This will install the Current Release Siebel Catalog, named SiebelAnalytics.webcat.

   (If the software is already installed, you are prompted to uninstall it first. During the uninstall, if you select the option to keep your current Web Catalog, it is copied and renamed to SiebelAnalytics.webcat.old. You can use this Web Catalog, or the copy in the temporary location, during the upgrade process.)

3. Make sure that your current Siebel Analytics repository has been migrated to version 7.5.

   For instructions, see Siebel Analytics Server Administration Guide.

4. Copy the Prior Release Siebel Catalog from the installation CD-ROM into the location that holds your Current Customer Catalog.

5. Open Analytics Catalog Manager and open the Current Release Siebel Catalog, SiebelAnalytics.webcat.

6. Choose Tools > Upgrade Catalog.

   The Upgrade Current Catalog window opens.

7. In the Initial Catalog area, browse to locate the Prior Release Siebel Catalog, SiebelAnalytics-7.0.4-GA.webcat.
8 In the Current Catalog area, browse to locate your Current Customer Catalog, SiebelAnalytics.webcat.old.

9 Click OK.

Analytics Catalog Manager will generate a baseline of the changes and compare your existing Web Catalog content with the content in the new version, merge in any changes, produce a report highlighting differences, and allow you to indicate how you want differences handled. If the Web Catalogs have conflicting content, you can choose which Web Catalog the content should be taken from.

The end result will be a merged Web Catalog that contains the site-specific changes, as well as new Siebel metadata. When the merge process completes, the Current Release Siebel Catalog that is loaded into Analytics Catalog Manager will contain the merged content.

The merge process may take several minutes. A message will alert you when the merge is complete.

**NOTE:** The log file SiebelAnalyticsMigrationLog.txt holds information about the merge process. This log file is written to the location that holds the Web Catalog. If you see an error logged in the file, this means that the path in question had a problem that did not allow the merge mechanism to resolve the merge. No action was taken. If you want to merge that particular item, you will want to go into your original Web Catalog and merge it manually.

10 Save the Current Release Siebel Catalog.

This catalog contains the merged content.
Localizing Web Catalog Text Strings

For organizations that need to localize text strings in the Web Catalog, this section explains how to export the text strings for translation, and then import the text strings when translation is complete.

The export and import processes are based on Extensible Markup Language (XML). You can optionally use an Extensible Stylesheet Language Transformations (XSLT) style sheet to transform the XML output and XML input.

To export Web Catalog text strings

1. Use Analytics Catalog Manager to open the Web Catalog that contains the text strings to be localized, and then choose Tools > Localization > Export.

2. If you want to use an XSLT style sheet, in the Localization Export window, browse to select the XSLT style sheet.

3. Browse to select the location to which the output will be written, and then click OK.

   The export process may take several minutes.

4. When the export process is complete, deliver the output file to your localization team.

To import Web Catalog text strings

1. Use Analytics Catalog Manager to open the Web Catalog that the localized text strings will be imported into, and then choose Tools > Localization > Import.

2. In the Import From field, browse to select the location that contains the XML file to be imported.

   The import process will determine the language from the XML file and store the string in the proper location in the Web Catalog.
If you want to override the language specified in the XML file, type the language extension to use from the following list.

<table>
<thead>
<tr>
<th>Language Extension</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>cs</td>
<td>Czech</td>
</tr>
<tr>
<td>da</td>
<td>Danish</td>
</tr>
<tr>
<td>de</td>
<td>German</td>
</tr>
<tr>
<td>en</td>
<td>English</td>
</tr>
<tr>
<td>es</td>
<td>Spanish</td>
</tr>
<tr>
<td>fi</td>
<td>Finnish</td>
</tr>
<tr>
<td>fr</td>
<td>French</td>
</tr>
<tr>
<td>he</td>
<td>Hebrew</td>
</tr>
<tr>
<td>it</td>
<td>Italian</td>
</tr>
<tr>
<td>ja</td>
<td>Japanese</td>
</tr>
<tr>
<td>ko</td>
<td>Korean</td>
</tr>
<tr>
<td>nl</td>
<td>Dutch</td>
</tr>
<tr>
<td>pt</td>
<td>Portuguese</td>
</tr>
<tr>
<td>pt-br</td>
<td>Brazilian Portuguese</td>
</tr>
<tr>
<td>sv</td>
<td>Swedish</td>
</tr>
<tr>
<td>zh</td>
<td>Chinese (Simplified)</td>
</tr>
<tr>
<td>zh-tw</td>
<td>Chinese (Traditional)</td>
</tr>
</tbody>
</table>

**NOTE:** If a message appears during import operations indicating that an XML syntax error was detected, open the XML file in a Web browser. The browser should parse the file and indicate the nature of the error. Correct the error and try the import operation again.
When the import is completed, choose File > Save to save the Web Catalog that now contains the localized strings.

Recommendations For Working with the Web Catalog

This section gives recommendations for working with Web Catalog content.

**CAUTION:** Make sure that the Analytics Catalog Manager is accessible only to Siebel Analytics Web administrators. As no login is required, full privileges for operations are granted to anyone who uses it.

- Use Analytics Catalog Manager only in offline mode. Never make modifications to an in-use Web Catalog.
- Always make backups of the Web Catalogs that you are working with. Also back up the .version file.
- When you want to work with two Web Catalogs, always open the second catalog from the Analytics Catalog Manager instance that you used to open the first catalog.
- When you are copying or pasting content from one Web Catalog to another, you need to stay within the same relative structure. For example, you can copy a report from a User folder to another User folder, but not from a User folder to a Shared folder.
- Copying and pasting into email is not supported.
- Do not attempt to reorder items in the Web Catalog using Analytics Catalog Manager.
Viewing Information About Dashboard Reports

This section explains how to use the catalog to view information about reports that appear on each page of a dashboard.

Organizations with Siebel Analytics applications can locate and view information about reports delivered with preconfigured dashboards. For information about preconfigured dashboards distributed with Siebel Analytics applications, see *Siebel Analytics User Guide*, and then use Analytics Catalog Manager to view information about the reports provided on each dashboard.

Exposing Dashboards and Reports

Depending on the Analytics options your organization purchased, the Siebel Analytics Web administrator may need to expose them before the associated dashboards and reports can be viewed in Siebel Analytics Web and in Analytics Catalog Manager. This applies to sites that have the following Siebel Analytics applications and options:

- Siebel Sales Analytics, with the Forecasting and Incentive Compensation options.
- Siebel Service Analytics, with the Universal Queuing, Email Response, and Agreements options.
- Siebel Sales Analytics, with the Forecasting and Incentive Compensation options.
- Siebel Partner Analytics, with the Partner Marketing, Partner ERM, and Partner ISS options.

These options need to be exposed using the administration feature in Siebel Analytics Web. For instructions, see *Siebel Analytics Installation and Configuration Guide*.

Locating Dashboard, Page, and Report Names

In Analytics Catalog Manager, the Web Catalog distributed with Siebel Analytics applications has the following structure:

Web Catalog > shared folder > Siebel Analytics application name > dashboard name > Page name > Report names
For example, Figure 5 shows the Sales folder in the shared folder, which contains the names of the preconfigured dashboards distributed with Siebel Sales Analytics, such as the Competitors dashboard. The Competitors dashboard contains pages such as Common, Industry, Overview, and so on. In the example, the Common dashboard has been opened to view the list of reports on that dashboard. The names of the reports are displayed in the Names list and have a type of Siebel Analytics Web Query.

![Figure 5. Sample Dashboard, Page, and Report Names](image)

**Generating a List of Reports**

This feature is useful for organizations that have one or more Siebel Analytics applications and want to see a list of the preconfigured reports distributed with the application. You can view the list in Analytics Catalog Manager, or save it in a file.

**To generate a list of reports**

1. In the Analytics Catalog Manager workspace, click the Siebel Analytics application, dashboard or dashboard page for which you want to view a list of reports.
2  Choose Tools > Catalog Report.

3  In the Create Catalog Report window, scroll down and select Report in the Select Items to be Displayed list, and then click the right arrow button ( > ) to move it into the Report list.

4  To view a list of reports, click OK.

   The list of reports is displayed in the Catalog Report window.

5  To save the list of reports in a file, use the Browse button to specify a location in the field Export Catalog to, and then click OK.

   The list of reports is displayed in the Catalog Report window, and the list is also saved to the location you specified. The report list has a .txt file extension.
Administering Catalog Items

You administer shared catalog folders through the Manage Catalog page of Siebel Analytics Web.

For information about changing permissions to a catalog item, see “About Setting Permissions” on page 104.

To display the shared catalog folders
1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Analytics Catalog hyperlink.
3. Click the Shared Folders link.

To create a new folder
■ Click the Create New Folder link and follow the instructions on the page.

To view the contents of a folder
■ Click the name of the folder to see its content.

To take ownership of an item
1. Navigate to the item.
2. Click the Properties icon for the item.
   The Item Properties page appears.
3. If you have the appropriate authority, you can take ownership of the item or folder by clicking either the:
   ■ Take Ownership of this item link
   ■ Take Ownership of this item and all subitems link

To rename a folder or an item
1. Navigate to the folder that you want to rename.
2. Click the Rename icon for the folder.
3. In the New Caption box, type a new name.
4 Click the Rename button.

**To delete a folder or an item**

1 Navigate to the folder that you want to delete.

2 Click the Delete icon for the folder.

   The Confirm Item Deletion page appears. When deleting shared folders or items, be aware that other users who have added shared items to their personal dashboards will no longer have access to them.

3 To confirm the delete, click Yes.

**To show hidden items**

1 In Siebel Answers, click the Admin hyperlink.

2 Click the Manage Analytics Catalog hyperlink.

3 Select the Show Hidden Items check box the bottom of the page.

   This allows you to see the following hidden items:
   
   - _Portal
   - _Filters
   - _Prefs
   - _Alerts
   - _iBots
   - _Delivers

**NOTE:** The availability of the Show Hidden Items check box is controlled by the See Hidden Items privilege. For more information, see "Default Privilege Assignments" on page 115.
Administering the Siebel Analytics Web Catalog

Administering Catalog Items
This chapter explains how to set up Siebel Analytics Web security so that employees only have:

- Access to items in the catalog that are appropriate to them
- The ability to perform actions that are appropriate to them

This chapter applies to you if your organization uses Siebel Analytics Stand-Alone or if your organization uses Siebel Analytics applications but has created additional content outside of the applications.

If your organization uses Siebel Analytics applications, refer to Security Guide for Siebel eBusiness Applications.
Overview of Siebel Analytics Web Security

This section provides an overview of Siebel Analytics Web security.

Where Security Settings Are Made

Security settings that affect Siebel Analytics Web are made in the:

- **Server Administration Tool.** This is where you:
  - Set permissions for business models, tables, columns, and subject areas
  - Specify database access for each user
  - Specify filters to limit the data accessible by users
  - Set authentication options

  For more information, see *Siebel Analytics Server Administration Guide*.

- **Siebel Analytics Web.** This is where you set permissions to catalog items, including dashboards, and the privilege to perform actions such as edit views, create iBots, and create prompts.

- **Catalog Manager.** This is where you set permissions to catalog items, including dashboards, when working offline.

Security Goals

Your main security goals are to make sure that:

- Only appropriate people can log on and access Siebel Analytics Web. This is achieved by assigning logon rights and authenticating users through the Analytics server. For more information about authentication, see “Authentication” on page 97.

- Employees can only access the data that is appropriate to them. This is achieved by applying access control in the form of permissions.

- Employees only have the ability to perform actions that are appropriate to them. This is achieved by applying user rights in the form of privileges.
Access Control and Permissions
Access control defines the ability of an account to access a shared catalog item. Catalog items are folders and reports, where folders are application folders, dashboard folders, and dashboard page folders. An account is either:

- An individual user
- A Web Group that has one or more users as members.

Permissions describe the type of access to an object that an account is permitted. Examples are Read and Full Control.

Each catalog item has an access control list that defines which accounts have which permissions to access the item. An access control list has the general form shown in Table 4.

Table 4. Access Control List For a Catalog Item

<table>
<thead>
<tr>
<th>Account</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Group 1</td>
<td>Read</td>
</tr>
<tr>
<td>Web Group 3</td>
<td>Full Control</td>
</tr>
<tr>
<td>Web Group 8</td>
<td>Read</td>
</tr>
<tr>
<td>User 4</td>
<td>Read</td>
</tr>
<tr>
<td>User 9</td>
<td>Full Control</td>
</tr>
<tr>
<td>User 11</td>
<td>Full Control</td>
</tr>
</tbody>
</table>

For more info about permissions, see “About Setting Permissions” on page 104.

User Rights and Privileges
Privileges are the actions that users have the right to perform in Siebel Analytics Web. Example privileges are “Edit system-wide column formats” and “Create iBots.”

Privileges are managed by associating them with accounts, that is, individual users or Web Groups. A specific account is either granted or denied a specific privilege. These associations are created in privilege assignment tables.
The general form of a privilege assignment table is shown in Table 5. The Web Groups in the right column are granted the privileges in the left column.

### Table 5. Privilege Assignment Table

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Accounts That Have Been Granted the Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privilege 1</td>
<td>Web Group 2, Web Group 4</td>
</tr>
<tr>
<td>Privilege 2</td>
<td>Web Group 1, Web Group 3</td>
</tr>
<tr>
<td>Privilege 3</td>
<td>Web Group 1, user 3</td>
</tr>
<tr>
<td>Privilege 4</td>
<td>Web Group 1, user 1, user 4, user 6</td>
</tr>
<tr>
<td>Privilege 5</td>
<td>Web Group 2, Web Group 3, user 4</td>
</tr>
</tbody>
</table>

If a user, or any Web Group to which the user is a member, is not assigned a particular privilege, by default that user is denied that privilege.

For more info about privileges, see “About Setting Privileges” on page 112.

### Authentication

Authentication is the process of using a username and password to identify a someone who is logging on. Authenticated users are then given appropriate authorization to access a system, in this case Siebel Analytics Web. Siebel Analytics Web does not have its own authentication system; it relies on the authentication system built into Siebel Analytics Server.

For more information about authentication, see “Authentication” on page 97.
About Web Groups

When a user is assigned to a Web Group, the user becomes a member of that group. Web Group membership is used to determine the permissions and privileges that are associated with a user, either by explicit assignment or inheritance.

Web Groups can also be thought of as roles for users because they avoid ambiguity about which defaults, preferences, and so on, to assign directly to the user.

Web Group Types

Web Groups are defined either by the system or an administrator.

**System-Defined Web Groups**
System-defined Web Groups are preconfigured and required for successful Siebel Analytics Web operations. There are three types of system-defined Web Groups.

**Everyone**
By default, all users belong to the Everyone group.

**Authenticated Users**
When a user is authenticated by the Analytics server, the user automatically becomes a member of the Authenticated Users group. The Authenticated Users group is itself a member of the Everyone group.

**Web Administrators**
Members of the Web Administrators group are users who are Siebel Analytics Web administrators. The default member of this group is the Siebel Analytics Web Administrator. By default, only members of the Web Administrators group have access to administrative functions, but this can be changed by changing privilege assignments.

**Administrator-Defined Web Groups**
Administrator-Defined Web Groups are created by the Siebel Analytics Web administrator. You can create an unlimited number of Web Groups in Siebel Analytics Web.
The Web Groups that you define should be used to categorize users who require similar access to dashboards and content. You should plan your catalog folder structure and Web Groups together to create a coherent security model. For more information about catalog structure, see Chapter 5, “Administering the Siebel Analytics Web Catalog.”

**NOTE:** For organizations that have Siebel Analytics applications, preconfigured groups are set up with preconfigured responsibilities. For more information, see *Siebel Analytics Installation and Configuration Guide.*
Administering Web Groups

When you create a Web Group, a group folder is automatically created in the catalog, to which all members of the Web Group are given Read permissions.

To create a Web Group

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Web Groups and Users hyperlink.
3. Under Existing Web Groups, scroll down and click the Create a new Web Group link.

   The Create Web Group page appears.
4. Enter a name for the group in the Group Name text box.

   The name of the Web Group must not match the name of any user who will log on to Siebel Analytics Web. This match is not case sensitive. For example, the user name FOO2 matches the Web Group named foo2 or FoO2. If a user and a Web Group share the same name, the user will receive an Invalid Account message when attempting to log on to Siebel Analytics Web.

   **NOTE:** If the name of a Siebel Analytics Server group (which is set up in the Siebel Analytics Administration Tool) matches the name of a Web Group, members of the Siebel Analytics Server group automatically become members of the Web Group when they log on to Siebel Analytics Web. Their membership ceases when they log off. The name of the user never appears to a Web administrator as a member of the Web Group. The user appears only as a member of the Authenticated Users group. If you prefer to use Web Group names that match Siebel Analytics Server group names, but want users to be viewable as members of the group, with persistent group membership, you must explicitly add the users to the Web Group using the Web Security: Groups and Users page.

5. (Optional). Enter a password for the group in the Password text box, and in the Verify Password text box type the password again.

   Users will be prompted for the password when they attempt to join the group.
6 In the Dashboard Name text box, type a name for the Dashboard.

You can assign an existing dashboard to the Web Group or create a new dashboard for the Web Group. Whichever option you choose, all members of the Web Group are granted Read access to the designated, default dashboard. If you do not want to create a dashboard now you can create one later from the Manage Dashboards page.

If you do create a new, empty dashboard, it is created within a new, like-named shared folder. Group members will have Read permission to this folder.

7 In the Dashboard Builder box, specify the name of the user or group that will have permission to change the contents of the dashboard.

Separate multiple entries with a comma, for example, user1,salesgroup.

8 Click Finished.

NOTE: Siebel Analytics Web will automatically give a newly created Web Group Read permission to the automatically created group folder. For manually created group folders, you should set the permissions to the Group folder for the appropriate groups to Read.

To delete a Web Group

1 In Siebel Answers, click the Admin hyperlink.

2 Click the Manage Web Groups and Users hyperlink.

3 Under Existing Web Groups, in the Web Groups table, locate the group you want to delete and click the Delete icon.

The Confirm Group Deletion page appears.

4 Click Yes to confirm the delete.

5 In the Web Security: Groups and Users page, click Finished.

NOTE: The procedure for deleting a Web Group does not delete any group definitions in a Siebel Analytics Repository.
To add a user or group to an existing group

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Web Groups and Users hyperlink.
3. Under Existing Web Groups, in the Web Groups table, locate the group whose membership you want to change,
4. Click the Edit icon.
   The Edit Web Group page appears.
5. In the Group Membership area, click the Add New Member link.
   The Add Member to Group page appears.
6. In the Member Name box, type the name of the user or group you want to add and click the Add Member button.
   The Edit Web Group page appears. The Group Membership area now shows the list of the current members of the group.
7. Click Finished.

To delete a user or group from an existing group

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Web Groups and Users hyperlink.
3. Under Existing Web Groups, in the Web Groups table, locate the group whose membership you want to change and click the Edit icon.
   The Edit Web Group page appears.
4. Under Group Membership, in the Members table, locate the member you want to delete and click the Remove icon.
5. (Optional) At the Edit Web Group page, change the password for the group.
6. Click Finished.

NOTE: The user name Administrator cannot be deleted.
To change the password for a group

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Web Groups and Users hyperlink.
3. Under Existing Web Groups, in the Web Groups table, locate the group whose password you want to change and click the Edit icon.
   
   The Edit Web Group page appears. The Password and Verify Password boxes will be blank.
4. Under Group Properties, in the Password box, type the new password.
5. In the Verify Password box, type the password a second time to verify it.
6. Click Finished.

To delete a user from Siebel Analytics Web

1. Under Authenticated Web Users, in the Web User and Group Membership table, locate the user you want to delete and click the Delete icon.
   
   The Confirm User Deletion page appears.
2. Click Yes to confirm the delete.
3. In the Web Security: Groups and Users page, click Finished.

NOTE: The procedure for deleting a user from Siebel Analytics Web does not delete any user definitions in a Siebel Analytics Repository. If the user logs on again, their entry will be recreated.
Authentication

When users log on, they are authenticated by the Analytics server, using their user name and password, the authentication method specified in the NQConfig.ini file, and the list of user names and passwords stored in the Analytics server repository.

The Siebel Analytics Server supports the following authentication methods that are relevant to Siebel Analytics Web users:

- LDAP Authentication
- External Table Authentication
- Database Authentication
- Internal Authentication

These methods are briefly described below in the context of Siebel Analytics Web. For detailed information, see Siebel Analytics Server Administration Guide.

**LDAP Authentication**

If you are using LDAP authentication to provide Analytics server access control, you may also configure your LDAP server to provide other security information. For example, you could configure the name that is displayed in the Welcome text when the user logs on to the Siebel Analytics Web, and is specific to the Web Groups to which the user belongs. This information is contained in LDAP variables, which are passed to the Analytics server session variables during the process of user authentication.

The variable USER is a system session variable that is used with LDAP authentication. Whenever users log on to Siebel Analytics Web, their usernames and passwords are passed to the LDAP server for authentication. After successful authentication, other system or non-system session variables for each user can be populated from information returned by the LDAP server.

For more information about session variables, see “Web Groups and Session Variables” on page 99.
Analytics Web Security

Authentication

**External Table Authentication**
If you are using an external database table for authentication, the table can contain additional access control information. This includes the name that is displayed in the Welcome text when the user logs on to Siebel Analytics Web, and the Web Groups to which the user belongs.

Whenever users log in, their usernames and passwords are authenticated through SQL that queries this database table for authentication. After successful authentication, the results of this SQL query can be used to populate other system and non-system session variables for each user.

For more information about session variables, see “Web Groups and Session Variables” on page 99.

**Database Authentication**
The Analytics server can authenticate users through database logons. When a user attempts to log on to Siebel Analytics Web, the server attempts to use the logon name and password to connect to the authentication database, using the first connection pool associated with it. If this connection succeeds, the user is considered to be authenticated successfully.

Database authentication provides no mechanism to return additional access control information, such as the user’s display name or Web Group membership. If you are using database authentication, alone or in conjunction with external table authentication, you will need to explicitly add users to the appropriate Web Group.

**Internal Authentication**
Unlike database authentication, Analytics server internal authentication has no way to return additional access control information. If you are using Analytics server internal authentication, you will need to explicitly add users to the appropriate Web Group, because the GROUP variable is not used with internal authentication.
Web Groups and Session Variables

If the Analytics server is using an external table or LDAP server for authentication, you must configure system session variables in the repository.

A session variable block contains the SQL statement that is issued when each session begins. This block can contain system session variables with fixed meanings (such as USER, GROUP, DISPLAYNAME, and WEBGROUP) and other non-system session variables unique to your particular environment. See Siebel Analytics Server Administration Guide for additional information about using session variables.

You should also create a Web group to match each possible value returned in the GROUP or WEBGROUPS variable for which you want to control privileges and permissions to Siebel Analytics Web components and requests.

GROUP Session Variable
The GROUP variable contains one or more group names, separated by semicolons, that are also used by the Analytics server for security and content filtering. In many cases, these same groups will be sufficient to control access to Siebel Analytics Web content. Siebel Analytics applications have been preconfigured to use this GROUP variable technique to inherit group memberships from the Analytics server.

WEBGROUPS Session Variable
The WEBGROUPS session variable allows greater flexibility because you can define Web Groups that categorize the roles, or classes, of Web users. For example, you might create the following groups:

- A Basic group that can only access the dashboard
- A Standard group that has minimal access to Siebel Answers
- A Power Users group that has full access to Siebel Answers and minimal access to iBots (Siebel Delivers)
- An Administrative group with full access to all features
Setting Permissions and Privileges
When you have set up the Web Groups, create a catalog folder structure and assign appropriate privileges and permissions to each group. Keep in mind that each user can be associated with multiple roles by being a member of multiple Web Groups. Although WEBGROUPS can be used to control access to catalog content (permissions), usually GROUP will control content and WEBGROUPS will control the ability to perform actions (privileges).

**NOTE:** Some GROUPs may not have corresponding Web content. In this case, when you create the group, you can delete the group folder created for the group in the / Shared folder, and give the group permission to the other group folders and Subject Area folders as appropriate (see Chapter 5, “Administering the Siebel Analytics Web Catalog.” for more information).

For more information about the sequence in which to set up security, see “Guidelines for Setting Up Security in the Web Catalog and Dashboards” on page 118.

For more information about permissions, see “About Setting Permissions” on page 104.

For more information about privileges, see “About Setting Privileges” on page 112.
Inheritance of Permissions and Privileges

Permissions and privileges can be assigned to users directly or through membership in groups. From another perspective, permissions and privileges can be assigned explicitly or effectively. Effective permissions and privileges are assigned indirectly through Web Group inheritance, which is the recommended way to set up your security. Permissions and privilege inheritance occurs when one Web Group is a member of another Web Group.

Rules For Inheritance

■ Any permissions or privileges given explicitly to a user will override any permissions or privileges inherited from the Web Group that the user belongs to.

As an example, All Authenticated Users have access to Dashboard X, except for George.

■ If a user belongs to two groups and both groups are assigned permissions the least restrictive permissions are given to the user.

For example, if one group allows Read access and another allows Change access, the least restrictive access would be granted; in this example, Change access.

**NOTE:** The exception to this is if one of the two groups is explicitly denied the permissions, in which case the user will be denied.

■ If a user belongs to Web Group X, and Web Group X belongs to Web Group Y, any rule assigned to group X will override any rule assigned to group Y.

For example, if Marketing has Read permissions, Marketing Administrators, which is a member of Marketing, can have Full Control permissions.

■ Explicitly denying access takes precedence over any other permissions or privileges.

When assigning permissions or privileges it often useful to look at resolved permissions for users and groups at the bottom of the page to make sure that everyone is inheriting correctly.
Example

Figure 6 shows an example of how privileges are inherited through Web Groups.

In this example:

- User1 is a direct member of Group 1 and Group 2, and is an indirect member of Group 3, Group 4, and Group 5.
- The permissions and privileges from Group 1 are no access to DashboardA, Read access to DashboardB, and Full Control over DashboardC.
- If permissions and privileges are conflicting, the least restrictive level of authority is granted. Therefore, the inherited permissions and privileges from Group 2 include Change and Delete access to DashboardD.
Specifically prohibiting access always takes precedence over any other settings. Therefore, Group 1’s denial of access to DashboardA overrides Group 4’s Read access. The result is that Group 1 provides no access to DashboardA. Likewise, Group 5 provides no access to DashboardE because access to it is explicitly denied in Group2.

The total permissions and privileges granted to User1 are as follows:

- No access to DashboardA and DashboardE because access is specifically denied.
- Read access to DashboardB.
- Full Control over DashboardC.
- Change and Delete access to DashboardD.

**TIP:** It is recommended that you do not add the default Everyone or Authenticated Users Web Groups to any other Web Groups that you create. This makes sure that only the desired Web Groups (and users) have the specified permissions and privileges, by preventing users or authenticated users from unintentionally inheriting permissions and privileges from another Web Group.
About Setting Permissions

Permissions are used to control access to shared information contained in:

- Siebel Analytics Web Catalog items
- Siebel Intelligence Dashboards

Permissions, which may be explicitly set or inherited, are configured from:

- Siebel Analytics Web Administration page
- Siebel Analytics Web Catalog

To set permissions in the Web Catalog you must be working offline. Use this option when you are working in a development environment or when you plan to make many changes. You can set permissions from the level of the application all the way down to individual reports in either Siebel Analytics Web or Siebel Analytics Web Catalog.

Types of permissions

Siebel Analytics Web supports four permissions:

- **No Access.** Access will not be allowed for this user or group. Explicitly denying access take precedence over any other permission.

- **Read.** Authority given to view the contents of the item, folder or dashboard, but cannot make any changes.

- **Change/Delete.** Authority given to view content, and make changes or delete the content.

- **Full Control.** Authority given to view content, make changes or delete the content, set permissions, and delete the item, folder or dashboard.

Recommendations For Setting Permissions

Follow these recommendations when setting permissions:

- Assign permissions through Web Group membership, even if you want to assign permissions for a single user. For more information, see “About Web Groups” on page 91.
Set the permission to the Group folder for the appropriate groups to Read.

For groups (or users, if necessary) that are going to be modifying the dashboards and dashboard content accessible to the group, set the permissions for the group to Full Control. This will often be a builder group. While allowing change and delete control, Full Control also allows the specified group (or user) to set permissions, and to delete the item, folder, or dashboard.

For each Subject Area, grant Read permissions to the corresponding Subject Area folder within the Requests folder (and everything it contains). Make sure that the Authenticated Users and Everyone groups have no access effective permission to the Subject Area folder.

For groups that should be able to save requests for public use against a given Subject Area, grant them Full Control to the Subject Area folder and everything it contains, and likewise for the Common folder. See the Change Item Permissions help page for details on managing permissions for folders, items, and dashboards.

To make sure that only members of the designated Web Groups (or users) have access to Siebel Analytics Web Catalog folders, folder content, and Siebel Intelligence Dashboards, do not set explicit permissions for the default Web Groups Authenticated Users or Everyone.

**NOTE:** Siebel Analytics Web will not allow you to remove permissions for yourself or for the Administrator. This prevents you from locking yourself out of an item, folder, or dashboard.

**TIP:** Tip: If you want to provide a place for all users within a group to share requests with each other, create a folder under the Subject Area folder called, for example, Share or Publish, and give the entire group Change/Delete permission to just that folder.
Setting Permissions Through the Administration Page

You can change permissions to catalog items through the Administration page of Siebel Analytics Web.

To change permissions for a shared dashboard

1 In Siebel Answers, either:
   - Click the Admin hyperlink and then the Manage Intelligence Dashboards hyperlink.
   - Click the Manage button in the selection pane.

2 In the row of the dashboard for which you want to change permissions, click the Permissions icon.
   The Change Item Permissions page appears.

3 In the access control list, select a user or group and click the corresponding hyperlink to toggle through the types of permissions.

4 Click the Replace permissions with parent folder’s permissions hyperlink, if appropriate.

5 Select either or both:
   - Apply permissions to subfolders check box
   - Apply permissions to items within folder check box

6 Click Finished.

7 In the Manage Dashboards page, click Finished.

To change permissions for a dashboard page

1 In Siebel Answers, either:
   - Click the Admin hyperlink and then the Manage Intelligence Dashboards hyperlink.
   - Click the Manage button in the selection pane.
2 In the row of the dashboard for which you want to change permissions, click the Properties icon.

3 In the Existing Pages area, identify the page and click the associated Security icon.

4 In the access control list, select a user or group and click the corresponding hyperlink to toggle through the types of permissions.

5 Click the Replace permissions with parent folder’s permissions hyperlink, if appropriate.

6 Select either or both:
   - Apply permissions to subfolders check box
   - Apply permissions to items within folder check box

7 Click Finished, and then click either Yes or Yes All to confirm the override of permissions.

8 In the Dashboard Properties page, click Finished.

9 In the Manage Dashboards page, click Finished.

To change permissions for a shared catalog item

1 In Siebel Answers, either:
   - Click the Admin hyperlink and then the Manage Analytics Catalog hyperlink.
   - Click the Manage button in the selection pane.

2 Click the Shared Folder hyperlink to make sure you are working with shared folders.

3 Click a folder hyperlink and drill down to the relevant item.

4 In the row of the relevant catalog item, click the Permissions icon.

   The access control list for the item appears.

5 Identify the user or group that has explicit access to this item and whose permission you want to change.
6. Click the hyperlink next to the group or user until the permission that you want to assign appears.

7. Click Finished.

8. In the Confirm Override of Permissions section, click Yes to confirm.
Setting Permissions Through the Catalog

You can change permissions to catalog items through the Web Catalog. For general information about the Web Catalog, see Chapter 5, “Administering the Siebel Analytics Web Catalog.”

To set permissions

1. Open the catalog manager (see “About Analytics Catalog Manager” on page 67).

2. Navigate to an item.

3. To review permissions for the item, right-click the item in the Name list and select Permissions.
The Explicit Permissions list on the left side of the window shows the users and groups that have explicit permissions granted to this item. The Effective Permissions list on the right side of the window shows the users and groups that have access granted though group inheritance, and users and groups that have no access to the report.

**Table 6. Permissions and Their Definitions**

<table>
<thead>
<tr>
<th>Permission</th>
<th>What It Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Read permission.</td>
</tr>
<tr>
<td>W</td>
<td>Write permission</td>
</tr>
<tr>
<td>X</td>
<td>Traverse Folder permission. You can view the folders within this folder.</td>
</tr>
<tr>
<td>D</td>
<td>Delete permission.</td>
</tr>
<tr>
<td>P</td>
<td>Change Permission authority. You can alter the permissions on the item.</td>
</tr>
<tr>
<td>O</td>
<td>Owner permission, also known as Full Control. This includes the permissions in this table and means that you have full control over the item. This is the level of authority granted by default to the preconfigured Administrator user ID.</td>
</tr>
</tbody>
</table>

4 If you need to move a user or group into the Explicit Permissions list, select the name in the Effective Permissions list and click the left arrow button (<).

**NOTE:** To change a permission for user or group, it must be in the Explicit Permissions list. To view groups only, select the option Show groups only.

5 Select a user or group in the Explicit Permissions list.

6 Select the new permission from the drop-down list below the Explicit Permissions list.

7 Click OK to accept the changes.
8 Close the Permissions window.

**NOTE:** If you move a user or group from the Explicit Permissions list to the Effective Permissions list, the user or group privileges are reset to No Access. To move users or groups from one window to another, highlight them and click the right or left arrow button as appropriate.
About Setting Privileges

Privileges are the actions that users have the right to perform in Siebel Analytics Web. They are managed by associating them with accounts, that is, individual users or Web Groups. A specific account is either granted or denied a specific privilege. These associations are created in privilege assignment tables.

Like permissions, privileges are either explicitly set or inherited through group membership. Explicitly denying a privilege takes precedence over any granted, inherited privilege. For example, if a user is explicitly denied access to the privilege to edit column formulas in Siebel Answers, but is a member of a group that has inherited the privilege, the user cannot edit column formulas.

Unlike permissions, privileges are more commonly granted to the Everyone system Web Group. This allows users access to common Siebel Analytics Web features and functions.

**NOTE:** Privileges and permissions have some interaction. For example, a user who creates an item has, by default, the permission to change it. However, in some cases, this is not appropriate. To disable this ability, make the appropriate changes to deny the target user or group access to the Admin: Catalog Change Permissions privilege.

For a list of Siebel Analytics Web privileges, see “Default Privilege Assignments” on page 115.
Setting Privileges

The following procedures to administer privileges.

**To assign a user or group to a privilege**

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Privileges hyperlink.
3. Locate the privilege you want to change.
4. Click the user or Web Group name on the same row as the privilege.

   The Privilege page appears. It has two tables. The top table lists Web Groups and users with explicitly assigned privileges. The bottom table lists Web groups with inherited access (effective permissions) to this privilege.

5. (Optional). Click the Show users and groups hyperlink to toggle the display to include users with inherited access.
6. In the bottom table, identify the group or user to allow explicit access and click the Add link on the same row.

   The Web group or user is added to the top table.

**NOTE:** By default, a user who creates an item has the permission to change it. However, in some cases, this privilege should be disabled. Make the appropriate changes to deny the target user or group access to the Admin:Catalog Change Permissions privilege.

**To change explicit access to a privilege**

1. In Siebel Answers, click the Admin hyperlink.
2. Click the Manage Privileges hyperlink.
3. Locate the privilege you want to change in the upper table.
4. Either:
   - Click the hyperlink to toggle between Granted and Denied.
Click the Remove Permissions icon to delete explicit access to the privilege. In this case, the Web group or user moves to the bottom table, displaying inherited permissions.

5 Click Finished.
Default Privilege Assignments

Table 7 lists the privileges that can be controlled, along with the Web Group that is granted access to that privilege by default.

These privileges apply to Siebel Analytics Stand-Alone only. If you are using Siebel Analytics applications, see Siebel Analytics Installation and Configuration Guide for information about preconfigured privileges, called responsibilities.

Table 7. Privileges and Default Settings for Siebel Analytics Stand-Alone

<table>
<thead>
<tr>
<th>Component</th>
<th>Privilege Description</th>
<th>Web Group Granted Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>Access to Siebel Answers</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Access to Siebel Delivers and iBots</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Access to Siebel Analytics Web Administration</td>
<td>Web Administrators</td>
</tr>
<tr>
<td>Admin: Catalog</td>
<td>Change Permissions</td>
<td>Everyone</td>
</tr>
<tr>
<td>Admin: General</td>
<td>Manage Sessions</td>
<td>Web Administrator</td>
</tr>
<tr>
<td></td>
<td>Manage Dashboards</td>
<td>Web Administrators</td>
</tr>
<tr>
<td>Admin: Security</td>
<td>Manage Web Groups and Users</td>
<td>Web Administrators</td>
</tr>
<tr>
<td></td>
<td>Manage Privileges</td>
<td>Web Administrators</td>
</tr>
<tr>
<td></td>
<td>Take Ownership of Catalog Objects</td>
<td>Web Administrators</td>
</tr>
<tr>
<td>Catalog</td>
<td>Personal Storage (My Folders and My Dashboard)</td>
<td>Everyone</td>
</tr>
<tr>
<td>Formatting</td>
<td>Edit system-wide column formats</td>
<td>Web Administrators</td>
</tr>
<tr>
<td></td>
<td>Edit personal column formats</td>
<td>No Access</td>
</tr>
</tbody>
</table>
### Table 7. Privileges and Default Settings for Siebel Analytics Stand-Alone

<table>
<thead>
<tr>
<th>Component</th>
<th>Privilege Description</th>
<th>Web Group Granted Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siebel Answers</td>
<td>Create Views</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Create Prompts</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Access the Advanced tab</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Edit Column formulas</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Edit Column filters</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Advanced SQL</td>
<td>Everyone</td>
</tr>
<tr>
<td>Siebel Delivers and iBots</td>
<td>Retrieve delivery destinations for iBots (system call)</td>
<td>Web Administrators</td>
</tr>
<tr>
<td></td>
<td>Create iBots</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Publish iBots for subscription</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Deliver iBots to specific or dynamically determined users</td>
<td>Web Administrators</td>
</tr>
<tr>
<td></td>
<td>Chain iBots together</td>
<td>Everyone</td>
</tr>
<tr>
<td></td>
<td>Chain iBots to custom scripts</td>
<td>Web Administrators</td>
</tr>
<tr>
<td>Subject Area (by its name)</td>
<td>Access within Siebel Answers</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Chart</td>
<td>Add and Edit Chart View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Column Filter</td>
<td>Add and Edit Column Filter View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Compound</td>
<td>Add and Edit Compound View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Filters</td>
<td>Add and Edit Filters View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Global Filters</td>
<td>Add and Edit Global Filter View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Image</td>
<td>Add and Edit Image View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Logical SQL</td>
<td>Add and Edit Logical SQL View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Narrative</td>
<td>Add and Edit Narrative View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Nested Request</td>
<td>Add and Edit Nested Request View</td>
<td>Everyone</td>
</tr>
</tbody>
</table>
### Table 7. Privileges and Default Settings for Siebel Analytics Stand-Alone

<table>
<thead>
<tr>
<th>Component</th>
<th>Privilege Description</th>
<th>Web Group Granted Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>View: Pivot Table</td>
<td>Add and Edit Pivot Table</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Question</td>
<td>Add and Edit Question View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Static Text</td>
<td>Add and Edit Static Text View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Table</td>
<td>Add and Edit Table View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Ticker</td>
<td>Add and Edit Ticker View</td>
<td>Everyone</td>
</tr>
<tr>
<td>View: Title</td>
<td>Add and Edit Title View</td>
<td>Everyone</td>
</tr>
</tbody>
</table>
Guidelines for Setting Up Security in the Web Catalog and Dashboards

To set up a secure Web catalog and secure dashboards, you must understand the information presented in the previous chapters as you will be working with the catalog, dashboards, and Web Groups.

The overall process is:

1. Create Web Groups.
2. Set Up the Catalog Structure.
3. Set Permissions To Catalog Items.
4. Create Shared Dashboards.
5. Add Shared Pages, Columns, and Sections.
6. Add Shared Content.
7. Test the Dashboards.
9. Release the Dashboards To the User Community.

Create Web Groups
When you create a Web Group, a shared catalog group folder is automatically created. For more information about Web Groups, see About Web Groups on page 91. For more information about the group folder, see Set Up the Catalog Structure.

Set Up the Catalog Structure
The Web Catalog has two main folders:

- /Shared. Contains the personal storage and My Dashboards for each user.
- /User. Contains shared folders, shared dashboards, and shared dashboard content.
Figure 7 shows the recommended higher-level folder structure for the catalog.

```
/Shared
  /<group name 1>
    /[folder 1]
      <Dashboard Section 1>
      <Dashboard Section 2>
      ...
    /[folder 2]
      <Dashboard Section 1>
      <Dashboard Section 2>
      ...
  /<group name 2>
    <Dashboard Section 1>
    <Dashboard Section 2>
    ...
/Common
  <Dashboard Section 1>
  <Dashboard Section 2>
  ...
/Requests
  /<subject area 1>
    /[folder 1]
      <request 1>
      <request 2>
      ...
    /[folder 2]
      <request 1>
      <request 2>
      ...
  /<subject area 2>
    <request 1>
    <request 2>
    ...
```

Figure 7. Recommended catalog folder structure

The catalog structure shown in Figure 7 makes it easier for users and administrators to reorganize content and make shared dashboard sections available. This, in turn, facilitates My Dashboard creation by allowing users to select from shared content.

Items shown within brackets ([ ]) are optional. Items shown within angle brackets (< >) should be replaced with the appropriate name.
Group Folder
When you create a Web Group, the system automatically creates a shared folder for the group. All members of the Web Group are automatically given Read permissions to this folder. These permissions are inherited by any subfolders that you create.

Group folders hold shared dashboard content that pertains to only members of the Web Group. The shared content can be further organized into subfolders under the Group folder.

NOTE: You may want to remove this folder and grant group permissions to other folders if there is no group-specific content.

Common Folder
Dashboard sections that are shared across groups are saved in a Common folder under the /Shared folder. Content can be organized into subfolders under the Common folder.

Requests Folder
When you create requests in Siebel Answers that you want to share, save them in a Requests folder in the /Shared folder.

Create a folder for each subject area in the Requests folder for storing requests against that subject area. This allows you to manage permissions at the level of the subject area. If two or more subject areas are closely related, so that users with permission to one would almost always have permission to the other, you could create a single folder to store requests against both subject areas.

NOTE: If a user is given permission to a request in the catalog that references a Subject Area to which the user doesn’t have permission, the Siebel Analytics Server will still prevent the user from executing the request.

In cases where you have requests that span subject areas (requests that involve SQL subqueries), you can put them in the folder for any of the subject areas, or create a new folder for users that have permission to these subject areas.

For more information about working with the catalog, see Chapter 5, “Administering the Siebel Analytics Web Catalog.”
Set Permissions To Catalog Items
Before setting permissions to the catalog items you have created, review the information in “About Setting Permissions” on page 104.

Create Shared Dashboards
After setting up the catalog structure and setting permissions, you can create shared dashboards and content for reuse by others. If you did not specify a dashboard when creating a group, you can create one now, selecting the appropriate group folder.

The advantage to creating shared dashboards is that sections that are created in the shared dashboard are actually shortcuts to folders in the /Shared catalog. As such, you can remove them and add them again in a different column, page, or even a different dashboard. Users can quickly create a My Dashboard from existing shared sections by clicking the Add Folder link and selecting the appropriate folder from the /Shared/Group or /Shared/Common folders in the catalog.

If you plan to allow multiple users to modify the Web Group’s default dashboard, consider putting these users into another group. For example, suppose you create a Web Group called Sales and create a default dashboard called SalesHome. Of the 40 users that are members of the Sales group, suppose that there are three who need to have the ability to create and modify content for the SalesHome dashboard. It is recommended that you create a SalesAdmin group, with the same back-end permissions of the primary Sales group. Add the three users who will be allowed to make changes to the SalesHome dashboard and content to this new SalesAdmin group, and give this group the appropriate permissions to the Web Catalog. This allows them to create and modify content for the SalesHome dashboard. If a user no longer requires the ability to modify dashboard content, you can change the user’s group membership to Sales. If an existing Sales group member needs to have the ability create dashboard content, the user’s group membership can be changed to SalesAdmin.
Dashboards are stored in a special folder that is hidden (unless "show hidden items" is checked when working with the catalog). The hidden _Portal folder is located directly underneath a group folder, as shown in this example in Figure 8. Because the dashboard is contained in the Group folder, all the permissions you set to the group folder will be inherited.

```
    /Shared
    └ /SalesGroup
        └ /Portal
            └ /SalesGroup Dashboard
                └ /Dashboard page 1
                    └ /column 1
                        └ section 1
                    └ /column 2
                        └ section 1
```

**Figure 8. Dashboard Folder Structure in the Catalog**

You can create multiple dashboards within a group folder, each of which will have its own folder in the _Portal folder, named from the dashboard name that you assign.

Underneath the specific dashboard folder, for example, _Portal/SalesGroup Dashboard, are folders that correspond to the pages you have created in the dashboard.

Underneath the page folder are folders for the columns. Column folders are assigned names automatically by the system. Within the column folders are the sections (folders or shortcuts to folders) that contain the items or shortcuts to items that appear in the dashboard.

For more information about creating shared dashboards, see “Creating and Deleting Shared Dashboards” on page 48.
Add Shared Pages, Columns, and Sections
After you have created dashboards, you can add pages, columns, and sections in preparation for the content.

Adding Pages and Columns
For information about adding pages and columns, see Siebel Analytics User Guide.

Adding Sections
A section is a folder, or a shortcut to a folder, that appears within a dashboard. For the procedure for adding sections to a dashboard, see “Creating and Deleting Shared Dashboards” on page 48.

When adding requests from Siebel Answers to a section, either:

- Include requests previously saved to the Subject Area folders.
- Create a new request, save it in the appropriate Subject Area folder, and add it to the shared section using the Existing Request link.

This technique is preferred for several reasons. The permissions on the Subject Area folders will automatically filter requests from the dashboard from users that might have dashboard permission, but not permission to certain subject areas. It is easy to reference the same request in multiple dashboard sections, you can change it once, and have it reflected in all sections.

If you are working with content that is specific to a number of group folders, you might want to create a new folder directly underneath the /Shared folder to use, and set permissions to the new folder to Read for the appropriate groups.
Add Shared Content
You can create shared content that can be used within shared and My Dashboard sections. For example, you could create a library of images by creating a folder called Images in the /Shared/Common folder. Add this folder as a section in a dashboard, perhaps the My Dashboard of the Administrator (although it does not really matter because once you place the images in the section you can remove it from the dashboard). Remember, it is a shared section, so the folder will still exist in the shared portion of the catalog. Edit the section and click the Image link to add each image that you want in your library.

**NOTE:** If there are a number of libraries that you want to make available for sharing, you might want to create folders within the /Common folder called /Sections, and /Content or /Libraries, so it is easier distinguish when using the common sections and content in other dashboards. To use the shared content in a section of My Dashboard, the user can edit the desired section, click the Item from Catalog link, navigate to the /Shared/Common/Images folder, and click the image to include.

This same mechanism should be used for any logos, images, scripts, links, copyrights, and so on, that might be used in more than one dashboard or dashboard section. This allows you to change the item in one location and have it immediately reflected in all dashboards.

In this version of Siebel Analytics Web, the Existing Request and Item from Catalog links function identically. They allow you to choose any item, including existing requests, from the catalog. This places a shortcut to the item you select in the section.

Test the Dashboards
Before releasing dashboards and content to the user community, perform some tests.

**To test the dashboard**

1. Verify that users with appropriate permissions can correctly access it and view the intended content.

2. Verify that users without appropriate permissions cannot access the dashboard.
3 Verify that styles and skins are displayed as expected, and that other visual elements are as expected.

4 Correct any problems you find and test again, repeating this process until you are satisfied with the results.

**Set Up a Virtual Directory For Shared Documents**

It is recommended that you set up a virtual directory on the Web server for shared documents. Name the directory `/DashboardFiles` and map it to a shared network directory of the same name.

This allows users with the appropriate permissions to publish files to this folder, and reference these files by their relative URL names rather than by their fully qualified network share names, for example, `/DashboardFiles/AnnualReport.doc` instead of `\\SharedServer\CommonShare\DashboardFiles\AnnualReport.doc`.

**Release the Dashboards To the User Community**

After testing is complete, notify the user community that the dashboard is available, providing the relevant network address.
This chapter describes how to customize the appearance of the Web user interface for Siebel Analytics.

**NOTE:** In Siebel Analytics Web, customization of user interface elements and appearance is accomplished by modifying registry entries, XML message files, and styles and skins, and not through the use of JavaScript. It is recommended that you do not modify JavaScript files located in the folder `Web\App\Res` in the Siebel Analytics Web installation directory. This is because the objects and methods in these scripts may change, and because these files may be replaced when upgrading. (In a dashboard, users with the appropriate permissions can customize an individual dashboard section by adding HTML to it. This HTML can include JavaScript. For more information, see *Siebel Analytics User Guide*.)
Modifying UI Styles

Web developers with Administrator rights can modify the existing Siebel Cascading Style Sheets (CSS) to create a custom user interface.

Web administrators can modify the Siebel CSS files or the images stored in the default installation directory. The default images and style sheets are located in the installation directory at \SiebelAnalytics\Web\App\Res\s_Siebel7. Contained within this directory are the relevant subdirectories (b_mozilla_4.0, b_nscp, Charts, Images, Maps, Meters, PopBin, Portal, and Views) for the current Siebel style.

Working with Cascading Style Sheets

Web developers who work with and understand style sheets can modify the default Siebel styles. There are three files that affect most of the dashboard user interface:

- **PortalBanner.css.** Influences the overall appearance of a dashboard’s top section. This includes the dashboard’s names, links, and so on.

- **PortalContent.css.** Influences the overall appearance of a dashboard’s main content area.

- **Views.css.** Corresponds to each of the Siebel Analytics request views (Title, Table, Pivot Table, Chart, Narrative, Ticker, and so on).

To see an example default Siebel 7 style sheet, right-click the dashboard and select View Source to view the Web page within the Notepad text editor. Note that the three CSS files are referenced within the header of the Web page (<HEAD>...</HEAD>).

Next, perform a Find within the Notepad document and search for the keyword “class.” There will be a class variable for each available attribute from within one of the CSS files.

The first class that appears is the PortalBody class (<body class="PortalBody">). If you open up the PortalContent.css file, you will see a corresponding section for PortalBody. For example:

```css
 PortalBody {
   font-family: Verdana, Arial, Sans-serif;
   font-size: 9pt;
} ```
To modify the background color of the dashboard page, change the hexadecimal color from #FFFFFF (white) to the color of your choice.

To make the background color of the dashboard yellow, change the hexadecimal color from #FFFFFF to #FFFF00, and save the change. Go back to the Web browser and click the Refresh button to see the changes.

Continue making changes to the various CSS classes to adjust the overall look of any Siebel Analytics application. This can be a tedious process, but after you have a good understanding of the available or most commonly used classes, you can perform a find and replace within the text editor to make mass changes to a style.

CSS Attributes
Cascading style sheets allow Web developers to have control over any object within Siebel Analytics. You can change images, backgrounds, font colors and sizes, table cell gridlines and cell padding, and so on.

For more information about cascading style sheets, you can visit a resource such as MSDN at http://msdn.microsoft.com/library/default.asp?url=/workshop/author/css/reference/attributes.asp.

Creating a New Dashboard Style
The easiest way to create a new style is to copy the s_Siebel7 style folder \SiebelAnalytics\Web\App\Res\s_Siebel7 and paste it into the data directory at the location \SiebelAnalyticsData\Web\Res. Copying to the data directory rather than to the main installation directory prevents any customized CSS files and images from being overwritten during a software upgrade.

After the style has been copied, rename the directory from s_Siebel7 to a name that has meaning to you (such as s_ProspectName).
The b_mozilla_4.0 directory contains the important files for making quick changes to the dashboards.

**NOTE:** The Web server must be restarted before you can see the new style sheet from the dashboard’s Properties link.

---

**To create a new style**

1. Copy the s_Siebel7 directory.
2. Paste it to the Res directory in the SiebelAnalyticsData directory.
3. Make your modifications.

**Example: Customizing the Dashboard Banner Image**

The image bg_Banner.gif image is referenced on the top section of dashboards. Developers can open the bg_Banner.gif file and make changes, or delete and recreate a new bg_Banner.gif file.
Customizing Non-Dashboard Components

Siebel Answers can also be modified to match a certain look and feel. However, the CSS files for Answers are stored in the sk_ directory within the main installation directory (\SiebelAnalytics\Web\App\Res\sk_Siebel7). The location b_mozilla_4.0 contains the relevant CSS files that correspond to Siebel Answers, Siebel iBots, Siebel Analytics Web Administration, and so on.

Use the same logic that is described in “Modifying UI Styles” on page 128 to make modifications to the non-dashboard components of the Siebel Analytics user interface. The non-dashboard components are controlled globally. Users cannot toggle between multiple user interfaces for the non-dashboard components.

Customizing the User Interface Using XML Message Files

This section explains how to customize text elements in message files to manage the default appearance and behavior of the Siebel Analytics Web user interface using XML strings.

NOTE: The intent of this section is to allow organizations that have XML expertise to perform additional customization. If you do not have this expertise, contact Siebel Systems’ Services organization, or enlist the assistance of a third party, to help you with customization.

About the User Interface XML Message Files

You can customize many of the text elements that appear in Siebel Answers, Siebel Delivers, and on dashboard pages. Examples of text elements include the content of text strings, the text for prompts such as the names of links and buttons, and the text of error and informational messages that are displayed to users as the result of an action.
Customizing the User Interface

Customizing the User Interface Using XML Message Files

These text elements are contained in external message files that are distributed with Siebel Analytics Web. The message files are in XML format. Language-specific messages are located in the folder Web\App\Res\l_xx\Messages in the Siebel Analytics Web installation directory, where xx is the language identifier of the selected locale (for example, for english-usa, the identifier is en). Language-independent messages are located in the folder Web\App\Res\Messages in the Siebel Analytics Web installation directory.

You should not edit the message files directly because any changes would not be retained when you install newer versions or service releases. For more information, see “Customizing Messages” on page 133.

How Message Files Are Structured

The name of a particular message file indicates the kind of content that it holds. For example, messages in the file LogonMessages.xml hold message content related to the act of logging on and off the system. Within each XML file, the WebMessage name= tags define the names of the messages. These tags are called message identifiers.

A particular message may also reference the content of another message by using a MessageRef tag. For example, the following message in the file LogonMessages.xml references the value of another message:

```
<WebMessage name="kmsgAuthenticateNotLoggedOnToLogonClickHere">
  <HTML>
    You are not currently logged in to the
  </HTML>
  <MessageRef name="kmsgProductServer" />
</WebMessage>
```

The entry <MessageRef name="kmsgProductServer" /> in the previous message indicates that the name of the server is taken from the value of the kmsgProductServer message identifier. This message is located in the file ProductMessages.xml, and its value is Siebel Analytic Server:

```
<WebMessage name="kmsgProductServer" CRC="nnnnnnnnnnnnnnnnnnnnnnnnnnnn">
  <TEXT>Siebel Analytic Server</TEXT>
</WebMessage>
```
Some messages, such as those that contain copyright information and product names, are protected and cannot be changed. If you look in the file ProductMessages.xml, you will see text above the WebMessage tags that indicate that the associated names cannot be changed.

**Customizing Messages**

This section explains how to change the content of unprotected messages and provides several examples. The intent is to show you how to alter the text of messages, and not to teach you XML.

**To customize messages**

1. For the messages you want to customize, create like-named message identifiers and customize their text.

2. Create a custom messages folder named CustomMessages.

   **NOTE:** Organizations that have Siebel Analytics applications may already have a file present in this folder. This file enables Analytics support for Siebel Analytics applications, and should not be modified, moved, or deleted.

3. Place the messages in one or more XML files in the CustomMessages folder, and then place the CustomMessages folder in this location:

   \SiebelAnalyticsData\Web\analyticsRes\l_xx

   where SiebelAnalyticsData is the name of the data folder created during the installation process, and xx is the language identifier of the selected locale (for example, for english-usa, the identifier is en).

   If you are not concerned with multiple languages, place the folder in the l_en folder. Messages will default to l_en if a language-specific version is not found. You will need to create the l_xx folder in the analyticsRes folder.

4. Restart Siebel Analytics Server.
You can create as many XML files in the CustomMessages folder as you like, or you can create just one XML file that holds customized messages, for example, CustomMessages.xml.

**NOTE:** If you plan to support multiple languages, it is recommended that you place control messages, which are messages that are not translated, into one file named CustomControlMessages.xml. Place messages that are translated into another file named, for example, CustomUIMessages.xml. This allows you to place localized versions of the CustomUIMessages.xml file in each language folder as appropriate, such as \SiebelAnalyticsData\Web\analyticsRes\l_de\CustomMessages, \SiebelAnalyticsData\Web\analyticsRes\l_fr\CustomMessages, and so on.

**Resolution of Siebel Analytics WebMessage Name Tags**
During initialization, the Siebel Analytics Web server replaces the WebMessage name default text with those that have been customized, based on the following precedence order, from highest to lowest:

- XML in \SiebelAnalyticsData\Web\Res\l_xx\CustomMessages folder (language-specific folders).
- XML in \SiebelAnalyticsData\Web\Res\l_en\CustomMessages folder (for language-specific user logons if WebMessage name tags reside here, but are not in language-specific files).
- XML in \SiebelAnalyticsData\Web\Res\CustomMessages folder.
- XML in \SiebelAnalytics\Web\App\Res\l_xx\Messages folder.
- XML in \SiebelAnalytics\Web\App\Res\Messages folder.

**Sample XML Template**
The following is a template for a CustomMessages.xml file in the folder \SiebelAnalyticsData\Web\analyticsRes\l_xx\CustomMessages. An example follows the template.
You can copy this template from the readme file on the installation CD-ROM, paste it into a text editor, name it CustomMessages.xml (or any name you choose), and place it into the CustomMessages folder you have created in the appropriate \SiebelAnalyticsData\Web\analyticsRes\_xx folder.

Every message begins with a `<WebMessage name=>` tag and ends with a `</WebMessage>` tag. The message text that you can customize is contained between `<TEXT>` tags or `<HTML>` tags. To suppress the display, delete the text between the tags.

```xml
<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables>

  <WebMessageTable system="Custom Messages">
    <!-- The name of a message must match the name of the message you are overriding. -->
    <WebMessage name="kmsgExampleOverrideMessage">
      <!-- A message can have TEXT and/or HTML versions of it. It is not necessary to have both. (TEXT will be automatically converted to HTML when necessary). -->
      <TEXT>Example message.</TEXT> <!-- Format used in a text only output -->
      <HTML><b>Example message with bold HTML tags.</b></HTML> <!-- Format used in an HTML output -->
    </WebMessage>
  </WebMessageTable>
</WebMessageTables>
```
Sample CustomMessages.xml File
The following example shows four customized messages placed in the CustomMessages.xml file.

```xml
<?xml version="1.0" encoding="utf-8"?>
<WebMessageTables>

    <WebMessageTable system="Custom Messages">

        <!-- First message -->
        <WebMessage
            name="kmsgAuthenticateRemembermyIDandpassword">
            <TEXT>Remember my signon name and password.</TEXT>
        </WebMessage>

        <!-- Second message -->
        <WebMessage
            name="kkmsgPrivilegeDisplayerAccountUnknown">
            <TEXT>Unknown Account (<Param insert="1"/>). Call the Help Desk at extension 9999 to set up a new account.</TEXT>
        </WebMessage>

        <!-- Third message -->
        <WebMessage
            name="kmsgWelcomeFrameCreateNewRequest">
            <HTML>Create a <b>new request</b> by clicking on a Subject Area below. After creating the request, click on the <b>Done</b> button at the bottom of the page.</HTML>
        </WebMessage>
```
<WebMessage name="kmsgUIAdmin">
  <HTML></HTML>
</WebMessage>

The message identifier of the first message being customized is "kmsgAuthenticateRemembermyIDandpassword". The default text for this message is located in the file LogonMessages.xml in the folder Web\App\Res\l_xx\Messages in the installation directory.

The message identifier of the second message being customized is "kmsgPrivilegeDisplayerAccountUnknown". The default text for this message is located in the file ViewMessages.xml in the folder Web\App\Res\l_xx\Messages in the installation directory. This message contains a variable, ( <Param insert="1"/> ).

**NOTE:** If you are customizing a message that contains a variable, do not alter the variable. In the UNIX environment, be careful to preserve the case of the message name being customized.

The message identifier for the third message being customized is "kmsgWelcomeFrameCreateNewRequest". The default text for this message is located in the file SearchSysMessages.xml in the folder Web\App\Res\l_xx\Messages in the installation directory. This message is in HTML format and uses an HTML tag ( <b> ) to display text in bold letters.
The message identifier for the fourth message being customized is "kmsgUIADMIN". The default text for this message is located in the file UIMessages.xml in the folder Web\App\Res\l_xx\Messages in the installation directory. This message is in HTML format. This message identifier displays the Admin link at the top of each Siebel Answers, Siebel Delivers, or dashboard page. Deleting the Admin text between the <HTML> and </HTML> tags suppresses the display of the link.

Frequently Customized User Interface Messages

Messages that are frequently customized are located in the file UIMessages.xml. This file contain text strings for display elements and for links throughout the user interface.

For example, the following messages contain the text for the links Admin, Alerts!, and Answers in the user interface. You can customize the text, or delete the text to suppress the display of the link.

```xml
<WebMessage name="kmsgUIAdmin">
  <HTML>Admin</HTML>
</WebMessage>

<WebMessage name="kmsgUIAlerts">
  <HTML>Alerts!</HTML>
</WebMessage>

<WebMessage name="kmsgUIAnswers">
  <HTML>Answers</HTML>
</WebMessage>
```
Removing the Download (Excel) Hyperlink

Users can export the data for a report to either a CSV file or a Microsoft Excel file. If you do not want to support the download to Excel option, you can remove the hyperlink.

To remove the Download (Excel) hyperlink

1. Open the ViewsControlMessages.xml file.

2. Copy the following message to the CustomMessages.xml file:

   `<WebMessage name="kmsgEVCDownloadLinks">
   <HTML>
   <a insert="1">
   <MessageRef name="kmsgEVCLinkDownloadExcel" />
   </a>
   <a insert="2">
   <MessageRef name="kmsgEVCLinkDownloadData" />
   </a>
   </HTML>
   </WebMessage>`

3. Delete the first message identifier anchor:

   `<a insert="1">
   <MessageRef name="kmsgEVCLinkDownloadExcel" />
   </a>`


For more information about the CustomMessages.xml file, see “Sample CustomMessages.xml File” on page 136.
Customizing the Appearance of the Logon Pages

Users must log on to Siebel Analytics Web to gain access to Siebel Intelligence Dashboards, Siebel Answers, and other Siebel Analytics Web components. This provides a user interface to the Analytics server authentication process.

When Siebel Analytics Web is accessed, the user is presented with the default Siebel Analytics Web logon page. The user must enter an appropriate Siebel Analytics user name and password. When authentication is complete, the user gains access to the appropriate Siebel Analytics Web components, and the user’s default dashboard displays. For more information, see “Authentication” on page 97.

To customize the appearance of the logon pages

- Override the relevant messages in the file LogonControlMessages.xml.

For general information about customizing the user interface with XML messages, see “Customizing the User Interface Using XML Message Files” on page 131.

NOTE: This feature does not allow the Siebel Analytics Web administrator to control how users are actually authenticated.
This chapter explains application programming interfaces and other methods that you can use to integrate Siebel Analytics into your corporate environment.
Go and Dashboard URLs for Siebel Analytics Integration

Siebel Analytics Web provides entry points for most functionality exposed in the system. Calls can be made through HTTP using a simple URL syntax, or using JavaScript commands. In UNIX, interfaces are exposed through a Java Servlet. This section describes the most common calls and their syntax.

- “Using the Go URL” on page 142
- “Using the Dashboard URL” on page 146
- “Using the Go Command To Issue SQL and Pass Filters” on page 148

Using the Go URL

Siebel Analytics Web's Go URL is for use in incorporating specific Siebel Analytics results into external portals or applications. This is the URL used when you add a result to your favorites, or add a link to a request to your dashboard or an external Web site. It has a number of forms and optional arguments that can be used to control its behavior.

The Go command can be posted as a Form, or as issued as a URL. If you are issuing parameters as part of a URL, they need to be escaped properly. Spaces need to be replaced with plus (+) signs, and so on. For example, to pass East Region as a value, you type East+Region.

When called from within a Siebel Analytics Web page, such as a dashboard or an HTML result view, the URL should begin with this:

```
saw.dll?Go
```

When called from another page on the same Web server, the URL should begin with this:

```
/Analytics/saw.dll?Go
```

When referenced from a page on a different server (or sent through email, and so on), it should begin with the fully qualified server name or IP address:

```
http://server_name_or_ip_address/Analytics/saw.dll?Go
```
To test these commands, you can enter the fully qualified version into the Address field in Internet Explorer 5.

**About the Basic Go URL**
The basic Go URL needs the full Web Catalog path to the request you want to execute. It will return the default result view, as defined in the request.

For example, this returns the default result view as defined in the request, where SB2 is the name of the request to execute.

```
saw.dll?Go&Path=/Shared/Test/SB2
```

**Optional Parameters**
You can modify the behavior of Go by adding one or more of the following parameters. If an invalid URL is specified (for example, you type a parameter incorrectly), the browser will display a “The page cannot be found” error with the detailed text of “HTTP 400 - Bad Request.”

**NOTE:** In parameter descriptions, SB2 is the name of the request to execute.

- **User ID and Password.** If omitted, the user will be prompted for user ID and password information, unless the user chose the option to have logon information remembered when last logged on.

  This is the format, where uuu is the user ID and ppp is the password:

  ```
  &NQUser=uuu&NQPassword=ppp
  ```

  Example:

  ```
  saw.dll?Go&Path=/Shared/Test/SB2&NQUser=user1&NQPassword=rock
  ```

  This logs on as user1 with a password of rock, and executes the request.

- **Link Options.** The results will include links.

  This is the format:
&Options=x

The x can be one or more of the following letters:

<table>
<thead>
<tr>
<th>Letter</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>Modify Request</td>
</tr>
<tr>
<td>f</td>
<td>Printer Friendly</td>
</tr>
<tr>
<td>d</td>
<td>Download to Excel</td>
</tr>
<tr>
<td>r</td>
<td>Refresh Results</td>
</tr>
</tbody>
</table>

Example:

saw.dll?Go&Path=/Shared/Test/SB2&Options=md

This displays results with the links Modify Request and Download Data.

- **Printer Friendly.** Results are in a printer-friendly format, without the tape deck paging control, hot links, and so on.

  This is the format:

  &Action=print

  Example:

  saw.dll?Go&Path=/Shared/Test/SB2&Action=Print

- **Application Friendly.** Results are displayed in an application-friendly format, such as for Microsoft Excel, without the tape deck paging control, hot links, the Powered by Siebel Analytics phrase, and so on.

  This is the format:

  = &Action=Extract

  Example:
The Extract action also acts as a Navigate action (see “Passing Filters to the Go Command Through a URL (Navigation)” on page 148) so you can filter the results that are returned by the call.

- **Specific View.** This shows an individual result view rather than the default compound view.

  This is the format, where xx is the name of the view:

  `saw.dll?Go&Path=/Shared/Test/SB2&ViewName=xx`

  Example:

  `saw.dll?Go&Path=/Shared/Test/SB2&ViewName=Chart`

  Assuming that the request contains a Chart view named Chart, this displays just the Chart view.

- **Specific Style.** This shows the results using a specified style. If the style does not exist, the default will be used.

  This is the format, where xx is the name of the style:

  `saw.dll?Go&Path=/Shared/Test/SB2&Style=xx`

  Example:

  `saw.dll?Go&Path=/Shared/Test/SB2&Style=Lime`

  This uses the style named Lime to show the results.

- **Result Format.** This controls the format of the results.

  This is the format, where xx is XML or HTML:

  `saw.dll?Go&Path=/Shared/Test/SB2&Format=xx`

  Example:

  `saw.dll?Go&Path=/Shared/Test/SB2&Format=XML`

  This shows results in XML.
Displaying All Records in a Table
There are two ways to display all the records in the table:

- Set the Rows per Page property on the Table view to 10,000, and then use the basic Go. This is the easier of the two methods.
- Issue the following URL, assuming the View you want to control is called Table.

```
saw.dll?Go&Path=/Shared/Test/SB2&Action=Scroll&P5=-1&ViewID=go~Table
```

Using the Dashboard URL
The Dashboard command can be posted as a Form, or as issued as a URL. If you are issuing parameters as part of a URL, they need to be escaped properly. Spaces need to be replaced with plus ( + ) signs, and so on. For example, to pass East Region as a value, you type East + Region.

When called from within a Siebel Analytics Web page, such as a dashboard or an HTML result view, the URL should begin with this:

```
saw.dll?Dashboard
```

When called from another page on the same Web server, the URL should begin with this:

```
/Analytics/saw.dll?Dashboard
```

When referenced from a page on a different server (or sent through email, and so on), it should begin with the fully qualified server name or IP address:

```
http://server_name_or_ip_address/Analytics/saw.dll?Dashboard
```

To test these commands, you can enter the fully qualified version into the Address field in Internet Explorer 5.

About the Basic Dashboard URL
The basic Dashboard URL command needs no parameters. It will display the user’s default portal, after authenticating the user.

This is the format:
saw.dll?Dashboard

**Optional Parameters**

You can modify the behavior of Dashboard by adding one or more of the following parameters. If an invalid URL is specified (for example, you type a parameter incorrectly), the browser will return a “The page cannot be found” error with detailed text of “HTTP 400 - Bad Request.”

**NOTE:** In parameter descriptions, SB2 is the name of the request to execute.

**User ID and Password.** If omitted, the user will be prompted for user ID and password information, unless the user chose the option to have logon information remembered when last logged on. If using a Session ID or Ticket, pass it as the NQUser parameter.

This is the format, where uuu is the user ID, and ppp is the password:

&NQUser=uuu&NQPassword=ppp

Example:

saw.dll?Go&Path=/Shared/Test/SB2&NQUser=user1&NQPassword=rock

This logs on as user1 with a password of rock, and displays the dashboard.

**PortalPath.** This parameter allows you to direct the user to a specific dashboard. If the user does not have permission to the dashboard, an Access Denied error is returned.

This is the format, where ppp is the fully qualified path of the dashboard in the Web Catalog, and x+x is the name of the dashboard to display.

saw.dll?Dashboard&PortalPath=/Shared/Test/_Portal/x+x&NQUser=sessionid

Example:


This authenticates the user using the provided session ID, and displays the Sales Dashboard.
Using the Go Command To Issue SQL and Pass Filters

This section explains how to use the GO command to issue SQL, and how to pass filters to be used for navigation.

Issuing SQL Using the Go Command

The Go command can be used to issue Siebel Analytics SQL. These forms of the Go command return tabular results. The basic options from &Style= and &Options= can be used here as well.

To issue Siebel Analytics’s simplified SQL, include the escaped SQL as a parameter to the Go command. For example:

```
    saw.dll?Go&SQL=select+Region,Dollars+from+SupplierSales
```

where the FROM clause is the name of the Subject Area to query.

Alternatively, the command IssueRawSQL can be used to bypass the Web processing and issue SQL directly against the Analytics Server.

Passing Filters to the Go Command Through a URL (Navigation)

The Go command can also be used to pass context such as filters to a destination request. This is done by adding additional parameters to the call. You need to make sure that any columns you are passing are set up in the destination with Is Prompted filters, or specific default filters.

**Navigation Parameters**

The basic syntax of the navigation command is the same as presented earlier, but with the addition of the Action = Navigate parameter, and then population of the P1 - Pn parameters, as necessary.

```
    &Action=Navigate
    &P0=n   where n is the number of columns you wish to filter, currently 1 - 6.
```
&P1=op where op is one of the following operators.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>eq</td>
<td>Equal to or in.</td>
</tr>
<tr>
<td>neq</td>
<td>Not equal to or not in.</td>
</tr>
<tr>
<td>lt</td>
<td>Less than.</td>
</tr>
<tr>
<td>gt</td>
<td>Greater than.</td>
</tr>
<tr>
<td>ge</td>
<td>Greater than or equal to.</td>
</tr>
<tr>
<td>le</td>
<td>Less than or equal to.</td>
</tr>
<tr>
<td>bwith</td>
<td>Begins with.</td>
</tr>
<tr>
<td>ewith</td>
<td>Ends with.</td>
</tr>
<tr>
<td>cany</td>
<td>Contains any (of the values in &amp;P3).</td>
</tr>
<tr>
<td>call</td>
<td>Contains all (of the values in &amp;P3).</td>
</tr>
<tr>
<td>like</td>
<td>You will need to type %25 in place of the usual % wildcard. See the examples that follow.</td>
</tr>
<tr>
<td>top</td>
<td>&amp;P3 should contain 1 + n, where n is the number of top items you want to see.</td>
</tr>
<tr>
<td>bottom</td>
<td>&amp;P3 should contain 1 + n, where n is the number of bottom items you want to see.</td>
</tr>
<tr>
<td>bet</td>
<td>Between (&amp;P3 must have two values).</td>
</tr>
<tr>
<td>null</td>
<td>Is null (&amp;P3 must be 0 or omitted).</td>
</tr>
<tr>
<td>nnul</td>
<td>Is not null (&amp;P3 must be 0 or omitted).</td>
</tr>
</tbody>
</table>

&P2=ttt.ccc In this parameter, ttt is the table name and ccc is the column name. If the table or column contains spaces, it must be quoted with double-quotes. Spaces should be escaped as %20, for example, Measures."Dollar%20Sales".

&P3 = n + xxx + yyy + ... + zzz In this parameter, n is the number of values, and xxx, yyy, and zzz are the actual values.
Siebel Analytics Integration API

Using the Go Command To Issue SQL and Pass Filters

**NOTE:** The settings for &P1, &P2, and &P3 are repeated for &P4-P6, &P7-P9, &P8-P10, &P11-P13, &P14-P16, and &P17-P19 as necessary, depending on the value of &P0.

**Navigation Examples**

This returns records for the East and Central regions:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=eq&P2=Customers.Region&P3=2+Central+East

This returns records for like Regions E....t:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=like&P2=Customers.Region&P3=1+E%25t

This returns the top two regions by dollars sold:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2="Sales%20Facts".Dollars&P3=1+2

This returns records with between 20,000,000 and 25,000,000 in sales:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=1&P1=top&P2="Sales%20Facts".Dollars&P3=2+20000000+2500000

This returns records for Regions beginning with the letter E:

Saw.dll?Go&Path=/vate&P0=1&P1=bwith&P2=Customers.Region&P3=1+E

This returns records for Regions containing the letter E and having more than 20 million in sales:

Saw.dll?Go&Path=/Shared/Test/
SB2&Action=Navigate&P0=2&P1=cany&P2=Customers.Region&P3=1+e&P4=gt&P5="Sales%20Facts".Dollars&P6=1+20000000
Siebel Analytics Web navigation is currently supported from charts, table and pivot table views, HTML views, and external applications and Web pages. The destination search should have filters defined on columns for which it wants to receive context. These can be specific filters or, usually, the Is Prompted filter. In addition to the Table.Column value specifically referenced in the navigation call, all filters from the source report that have corresponding table.columns in the destination, will be applied to the destination. Therefore, the appropriate context from a source can be passed to the destination.

**Navigation From Charts**
From the chart properties page, check the Navigate radio button and enter the full path to the saved search or portal that you are interested in the field provided, for example `/shared/topaz/performance/transaction details`.

**Navigation Using JavaScript**
Navigation can currently be accomplished using the custom text/date formatter for a column. The central concept is that you add a column you want to navigate from to your search. You then choose Custom Text Format from the properties for the column, and enter HTML that calls one of the two provided JavaScript functions. This technique can be used to perform many actions, including sorting columns, calling custom JavaScript functions, and so on.

Siebel Analytics Web includes two JavaScript functions that enable navigation from Table and Pivot views: GoNav and PortalNav. (These functions are located in `/res/mozilla/viewhelper.js` if you are interested in seeing what they do.) The former handles navigation to a specific search. The latter handles navigation to a specific dashboard. A description of their syntax follows, along with example Custom Text formats that you can use to accomplish navigation.

**NOTE:** Siebel Analytics Web is standardized on the class = Nav, in order to control the look of the navigable text using the style sheet.
function GoNav(sPath, sTbl, sCol, sVal, sTarget) where

sPath = the catalog path of the destination search.

sTbl = the logical table name to filter.

sCol = the logical column name to filter.

sVal = the value to filter by.

sTarget (optional) = "_blank" to open a new browser window with the results.

Sample Custom Text Format for GoNav Call (include the quotes):

"<font class=nav onclick="JavaScript:GoNav('/shared/topaz/performance/transaction details','Transaction','Quality','"@"');">"@"</font>";

function PortalNav(sPortal, sTbl, sCol, sVal)  

sPortal = the catalog path of the destination portal.

sTbl = the logical table name to filter.

sCol = the logical column name to filter.

sVal = the value to filter by.

Sample Custom Text Format for PortalNav Call (include the quotes):

"<font class=nav onclick="JavaScript:PortalNav('/shared/topaz/_portal/transaction analysis','Transaction','Type','"@"');">"@"</font>"

Navigation From HTML Results

This is the same as the proceeding section, but rather than a custom formatter, type in the HTML syntax with static values in place of the @ signs.
This chapter illustrates the requirements for integrating a third-party SQL tool with Siebel Analytics by describing an example integration. Because Siebel Analytics was designed as a middleware platform for enterprise data access and integration, it is easy to allow common report writers and business intelligence tools to communicate natively with the Siebel Analytics Server.
Example of a Siebel Analytics Third-Party SQL Tool Integration

This section uses Microsoft Access to give an example of how Siebel Analytics can integrate with a third-party SQL tool.

Most third-party SQL tools require the user to include join conditions within queries, in order to avoid cross-joins. A cross-join occurs when a query does not have a WHERE clause, which, in turn creates a Cartesian product of the tables involved in the join. The size of a Cartesian product is the number of rows in the first table multiplied by the number of rows in the second table.

To integrate Microsoft Access with the Siebel Analytics Server, the Siebel Analytics Administrator must expose the keys within the Presentation layer of the Siebel Analytics Administration Tool.

**Example of integrating a third-party SQL tool**

1. Drag and drop the keys from the Business Model and Mapping layer to the Presentation layer.
2. Save the repository.
3. Open Microsoft Access and select the option Blank Access Database.
   - Microsoft Access will ask for a file name.
4. Type the name siebel-analytics.mdb, and press the Create button.
5. After creating the new Microsoft Access database, right-click in the white section of the screen and select Link Tables.
6. From the Files of Type drop-down list box, select ODBC Databases.
   - The Select a Source Dialog appears, and prompts you for a Data Source Name.
7. Click the Machine Data Source tab, locate the Analytics_Web DNS, and click OK.
   - The Siebel Analytics Server will require a login.
8. Type your user ID and password.
   - The Import Objects dialog box appears.
9 Click the Select All button, or highlight the desired logical tables from Siebel Analytics.

The import may take a while to complete.

10 When the import completes, right-click in the white section of the screen and select Relationships.

a Add the desired tables and drag and drop the keys from the dimension tables (Period, Market, Product) to the fact table (Sales Measures).

b Drag and drop Period Key over perkey, and repeat for each corresponding key, to create the joins.

Now, you can test and run a query.

11 Select Create query in Design view from the Queries button. Select Markets, Products and Sales Facts and add Region, Brand, Units and Dollars, respectively, and click the Run button.
Example of a Siebel Analytics Third-Party SQL Tool Integration
Index

A
Analytics Catalog Manager
  copying and pasting content 74
  defined 67
  definition of permissions 70
  list of dashboards, pages, and reports 82
  localizing Web Catalog text strings 78
  starting 68
  updating Web Catalog to newer version 75
  viewing information about reports 81
  working with permissions 71
  working with properties 71
  workspace 69
authentication
database 98
external table 98
LDAP 97

B
backup files for Web Catalog 59

C
cache settings
  for charts 19
  for queries 28
chart settings for chart image server 30
clients
  setting time for connections to expire 22
  setting time for sessions to expire 26
configuration file path setting 21
cookie domain, configuring 31
copying and pasting Web Catalog content 74
creating new Web Catalog 62
customizing
  changing location of Web Catalog 58
  configuring cookie domain 31
  creating ODBC DSN 19
  integrating Siebel Answers into other portals or intranets 54
  managing alert settings 45
  managing charting cache settings 19
  managing query cache settings 28
  managing URL generation 32
  registry settings created during installation 14
  setting configuration file path 21
  setting location where iBot deliveries are stored 46
  setting maximum number of rows in table view 39
  setting number of minutes between Web Catalog backups 61
  setting number of Web Catalog backups 61
  setting time to cancel unattended request 27
  setting time to expire for client connections 22
  setting time to expire for client sessions 26
  setting time to keep unsaved request 27
  setting time to log users off automatically 28
  settings for chart image server 30
  settings for pivot tables 38
  storing user names and passwords 21
  user interface message files 131
**Index**

**D**  
dashboards  
  using Analytics Catalog Manager to view information about  81  
  viewing list of  82  
database authentication overview  98

**E**  
external table authentication  
  overview  98

**F**  
filters, migrating repository changes to  66

**I**  
iBots  
  location for stored deliveries  46  
  managing alert settings  45  
  integrating Siebel Answers into other portals or intranets  54  
  internal authentication  98

**L**  
LDAP authentication overview  97  
load failure recovery for Web Catalog  63

**M**  
message files  
  customizing message text  133  
  frequently customized messages  138  
  sample customized file  136  
  sample XML template  134  
  structure  132  
migrating repository changes to filters  66  
to requests  66  
moving Web Catalog to new system  64

**O**  
ODBC DSN, creating  19  
opening Analytics Catalog Manager  68

**P**  
pages, viewing list of  82  
passwords, storing  21  
pivot tables, registry settings for  38

**Q**  
query cache settings, managing for Siebel Analytics Web  28

**R**  
registry settings  
  created during installation  14  
reports  
  using Analytics Catalog Manager to view information  81  
  viewing list of  82  
requests  
  migrating repository changes to  66  
  setting time to cancel unattended request  27  
  setting time to keep unsaved requests  27

**S**  
security  
  database authentication  98  
  external table authentication  98  
  LDAP authentication  97  
  starting Analytics Catalog Manager  68

**T**  
table view, setting maximum number of rows in  39

**U**  
UNIX  
Registry editor, accessing  16  
Registry editor, example entries  18  
user names  
  logging off automatically  28  
  storing  21

**V**  
version file for Web Catalog  59
W
Web Catalog
  backup files  59
  changing location of  58
  copying and pasting content  74
  creating  62
  load failure recovery  63
  localizing text strings  78
  moving to new system  64
  setting number of backups  61
  setting number of minutes between backups  61
  updating to newer version  75
  version file  59
  workspace for Analytics Catalog Manager  69